
Keystone® 600N5
Training Manual



1



Keystone® 
600N5 
Training 
Manual

5



ii
Copyright ©1996, 1997, 1998, 1999, 2007 Stanley Security 
Solutions, Inc. All rights reserved.

Information in this document is subject to change without notice 
and does not represent a commitment on the part of Stanley 
Security Solutions, Inc.

This publication is intended to be an accurate description and set 
of instructions pertaining to its subject matter. However, as with any 
publication of this complexity, errors or omissions are possible. 
Please call your Stanley Security Solutions, Inc. representative if 
you see any errors or have any questions. No part of this manual 
and/or databases may be reproduced or transmitted in any form or 
by any means electronic or mechanical, including photocopying, 
recording, or information storage and retrieval systems, for any 
purpose other than the purchaser’s personal use, without the 
express written permission of Stanley Security Solutions, Inc.

This document is distributed as is, without warranty of any kind, 
either express or implied, respecting the contents of this book, 
including but not limited to implied warranties for the publication’s 
quality, performance, merchantability, or fitness for any particular 
use. Neither Stanley Security Solutions, Inc., nor its dealers or 
distributors shall be liable to the user or any other person or entity 
with respect to any liability, loss, or damage caused or alleged to 
be caused directly or indirectly by this publication. 

Written and designed by Stanley Security Solutions, Inc. and 
Avalon Group, Inc, Indianapolis, Indiana.



Please read!
This is very important 
information!
The security of a Facility is only as good as your key control!

Before starting this manual or beginning on your Keystone 600 
program, there are a few general parameters to the program you 
should always keep in mind.

Always start with the Masterkey Card first. See Module 6. The 
program is designed around this card being filled in first and being 
correct. If you have questions as to what this card is about or 
represents, please contact your local office for assistance.

There are only two steps to filling in the Masterkey Card 
information. The following are the two steps to always remember:

1 Highlight or click on the Keymark level that is one step higher 
than the one you are adding. Example: If you were adding a 
Master A you would highlight the Grand Master. If you were 
adding an A1 operating level Keymark, you would highlight the 
Master A.

2 Select F7 if you are adding a Master level Keymark of some 
kind or select F9 if you are adding an operating (or the lowest 
level) Keymark and matching Coremark.

NOTE: Never add Keymarks or Coremarks from the Keymark or 
Coremark Cards themselves. Always add them from the Masterkey 
Card only.

There are 2 general rules of using the Keystone 600:

1 Whenever you want to add a record, go to that Card record tab 
at the top of the screen and select the F3 Add ….Record. The 
F3 Button is in the lower left hand side of the screen.

2 Whenever you want to edit or change a Card Record, go to that 
Card record tab at the top of the screen and select the EDIT 
MENU BUTTON first and then select the appropriate F function 
key shown. The Edit Menu Button is located on the lower right 
hand side of the screen.

For Keystone 600 technical support, please phone 800-964-5625, 
option 6.
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MODULE 1

Purpose of 
Module 1

The purpose of this module is to help you

■ get acquainted with the features and structure of Keystone 600 

■ learn basic terminology about using a database in general and about 
using Keystone 600 in particular

■ learn how to use the PC keyboard and mouse to navigate 
Keystone 600

Objectives for 
Module 1

When this module is complete, you’ll be able to

■ start, log into, log off, and exit Keystone 600

■ locate information tracked by Keystone 600

■ understand the information that appears on cards, details, and cross 
references

■ use the Keystone 600 help system to learn more about the program

Overview of 
Module 1

The topics covered in this module are

■ an overview of Keystone 600’s features

■ the relationship between categories of information tracked by 
Keystone 600

A code is a sequence of 
numbers indicating the 
keycut for a keymark. 
This code can be used to 
cut a key for a keymark.

— codes

— people

— places

— things

— transactions

■ important concepts to help you understand the Keystone 600 system

■ how to

— restore a database backup

— start, log into, log off, and exit Keystone 600

— use the keyboard and mouse to navigate Keystone 600
Issue 3 March 2007 Page 1-1
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Starting 
Keystone 600

To start Keystone 600 using the default login
1 Launch Keystone 600 from Windows.

The Login dialog box appears.

For assistance with 
launching a program from 
Windows, refer to the 
documentation that came 
with your Windows 
software.

2 In the Name field, type BEST.

The default login is BEST 
and the default password 
is BEST. Later you’ll 
learn how to change the 
password for the BEST 
login.

3 In the Password field, type BEST.

4 Select OK.

The Keystone 600 screen, like the one in the Figure below, appears. 
The figure shows the areas of the Keystone 600 screen.

To highlight a list entry
■ press the up or down 
arrow
■ click the mouse on the 
entry
■ type the entry name in 
the Find box

To access the Demo facility
1 After logging into the Keystone 600 Program, you will be at the Demo 

Facility Card. If not, go to the next step.

2 Select Find a Facility (press F10 or click the mouse on Find a Facility).

The Facility finder appears listing all of the facilities at this site.

3 Select Demo Facility. (Press the up or down arrow key until Demo 
Facility is highlighted, then press Enter. Or double-click the mouse on 
Demo Facility).

Figure 1.1 Introductory screen showing how to navigate 
Keystone 600.

Main menu

Card tabs

Detail and 
cross-refer-

Quick access 
menus
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Keystone 600’s 
Features

Keystone 600 is an extremely flexible software package that lets you track 
all of the information related to your facility’s access control system. 

As we’ll see throughout this course

Your access control 
system is your entire 
system for restricting the 
movement of people into 
and within areas 
protected by the system.

■ Keystone 600 provides many ways to locate the information you need. 
For users familiar with the G600 software package, Keystone 600 
software is structured similarly and lets you use the function keys you 
are used to. For Windows users, Keystone 600 makes it easy to 
navigate using a mouse.

■ Keystone 600 makes it easy to add information to your records and to 
update information whenever necessary

A transaction is an 
activity performed using 
Keystone 600 that 
changes the disposition of 
an item. Transactions 
include issuing items, 
returning items, 
transferring items, 
installing items, and 
removing items.

■ Keystone 600 lets you track all transactions you perform including

— issuing items to employees, returning items from employees, and 
transferring items between employees

— installing cores and locks in doors, installing cores in locks and 
doors, and removing locks and cores

■ Keystone 600 provides special tools to help you build cores and cut 
keys, including

— an automatic pin segment calculator. For more information see 
“Activity 3: Managing Coremarks” on page 6-22.

— a manual pin segment calculator. For more information see 
“Adding and Editing a Masterkey Card, Grandmaster Keymark 
Card, and Control Keymark Card” on page 6-7.

— the ability to print work slips providing specific instructions for 
cutting the keys you need and building the cores you need

■ Keystone 600 makes it easy to print the lists and reports you need to 
manage your access control system

■ Keystone 600’s security features include

— password protection. For more information see “Activity 2: 
Managing Users” on page 7-3.

— the ability to give users access to only the information they need to 
do their job

— the ability to restrict the activities each user can perform

— an easy-to-use backup feature. For more information see “Activity 
3: Managing Facilities” on page 7-9.

■ Keystone 600 includes an extensive on-line help system that makes it 
easy to get instructions when you need them
Issue 3 March 2007 Page 1-3
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Exploring 
Keystone 600

To see how all of Keystone 600’s cards work together, pretend you are 
setting up a new access control system for a new company.

Keystone 600 can manage 
the records for multiple 
facilities. In the Keystone 
600 Program a facility is 
a separate database. 
Please phone Technical 
Support before creating 
new facilities.

A user is a person who 
has access to the 
Keystone 600 system.

You can create a user card for each person who needs to use the software 
at your site. Then you can select permissions for each user. Permissions 
define which cards a user can view and which activities a user can perform 
using Keystone 600. 

To see user permissions, click the mouse on the User card tab near 
the top right-hand side of the screen.

Then click on the Permissions detail tab toward the bottom of the 
screen, if not already displayed.

When Stanley Security Solutions gives you the code sheets for your 
company:

■ You want to add this code information at the Masterkey Card. See 
“Adding and Editing a Masterkey Card, Grandmaster Keymark Card, 
and Control Keymark Card” on page 6-7.

A masterkey system is a 
system comprised of 
keymarks and coremarks 
that lets a single key 
operate many cores, and 
also lets each core be 
operated by its own or 
other keys. A facility can 
have one or more 
masterkey systems.

A facility is a group of 
buildings and employees 
tracked by Keystone 600. 
Do not create new 
facilities before 
contacting Technical 
Support.

■ You must add a Masterkey card for all of your company’s masterkey 
systems. When you add a Masterkey card, Keystone 600 will ask you 
to add the grandmaster and control keymarks. You must add them at 
this time. You cannot add them later. Only when creating a Masterkey 
card can they be added.

To see masterkey information, click the mouse on the Masterkey card 
tab near the top of the screen.

A keymark is a sequence 
of letters and numbers 
that directly corresponds 
to a keycut pattern for a 
key or group of keys that 
operates a particular core 
or lock.

A coremark is a sequence 
of letters and numbers 
that indirectly 
corresponds to a pin 
segment configuration for 
a core in a masterkey 
system.

■ Then you can add a Keymark for each code in your masterkey system. 
When you add a keymark, the program will automatically add a 
Keymark and corresponding Coremark card for you.

To see keymark information, click the mouse on the Keymark card tab 
near the top of the screen.

To see coremark information, click on the Coremark card tab near the 
top of the screen.

Important: Always add your Keymarks and Coremarks at the 
Masterkey card. Do not add them at the Keymark or 
Coremark cards.
Page 1-4 March 2007 Issue 3
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A building is any 
structure in a facility 
database. A building can 
be assigned to a zone.

A door is an access point 
in a building. Doors, 
gates, and even drawers 
can be considered doors. 
A door can be assigned to 
a building and to an area 
in a building.

Now you can add a Building card for each building in your facility. Then you 
can add a Door card for each door in each building.

To see building information, click the mouse on the Building card tab 
near the top of the screen.

To see door information, click on the Door card tab near the top of the 
screen.

A core is an 
interchangeable device 
that can be installed in a 
lock or door and operated 
by a key. In most 
masterkey systems, one 
or more interchangeable 
cores can be installed in a 
lock.

■ Now you can add a Part card for each Part installed in a door, and you 
can add a Core card for each core installed in a lock or door. Use 
Keystone 600 to track the installation of each Part or core.

To see Part information, click the mouse on the Part card tab near the 
top of the screen.

To see core information, click on the Core card tab near the top of the 
screen.

This detail shows the 
Parts installed in the 
selected door. It also 
shows any cores installed 
in those Parts.

To see how Keystone 600 pulls together the information you provide, 
click the mouse on the Door card tab near the top of the screen.

Next click on the Parts detail tab near the bottom of the screen. The 
Part installed in the selected door appear.

Press F2 to view the Part installed in the next door in the records.

A pin segment is a 
cylindrical-shaped part 
that fits into the barrels 
of a core. The sequence of 
varying length pin 
segments in a core is 
what creates the 
combination for a core.

An employee is a person 
who works at a facility.

■ Keystone 600 also can help when you need to build (combinate) a 
core. If you’ve entered all of your masterkey system codes correctly 
using Keystone 600, Keystone 600 can automatically calculate the pin 
segments for a core based on a selected coremark.

To see pin segment information, click the mouse on the Coremark card 
tab near the top of the screen.

Then click on the Pin Segments detail tab near the bottom of the 
screen.

A key is a device that 
operates a core or lock. 
A key or an electronic 
access device can be 
considered a key.

■ You can issue keys to employees. Add an Employee card for each 
employee in your company. Then issues keys to each employee you 
create. When you issue a key to an employee, use Keystone 600 to 
track the transaction.

To see employee information, click the mouse on the Employee card 
tab near the top of the screen if the Employee Card is not currently 
displayed. 

To see how Keystone 600 pulls together employee information and key 
information.
Issue 3 March 2007 Page 1-5
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This detail shows the 
keys held by the selected 
employee.

Click on the Keys detail tab near the bottom of the screen, if not 
already displayed.

You can use Keystone 600 
to print lists and reports 
to help you manage your 
security information.

■ Not only do you use Keystone 600 to add information, you also use 
Keystone 600 to maintain all of the records for your access control 
system on an ongoing basis.

To see the reports available to you, click the mouse on the Reports 
card tab near the top of the screen.

Then Press F10 to see the list of available reports.

To continue, press the Esc key.

Unassigned is a possible 
disposition for an item. If 
an item is not issued to 
an employee, installed in 
a Part or door, attached 
to a keyring, on a cabinet 
hook, or out of service 
(destroyed, lost, or 
stolen), it is considered 
unassigned.

■ Keystone 600 also provides special features for managing cores, keys, 
keyrings, and Part. When cards for these items are first created, these 
items are unassigned.

Cores, keys, keyrings, and Part can be stored on hooks in cabinets. 
Also, keys can be attached to keyrings, which can be issued to 
employees or stored on cabinet hooks.

To see the unassigned items, click the mouse on the Unassigned card 
tab near the top of the screen.

A cabinet is a place where 
cores, keys, keyrings, and/
or Parts are stored. 
Cabinets, closets, file 
drawers, and other 
storage areas can be 
considered cabinets.

To see cabinet information, click on the Cabinet card tab near the top 
of the screen.

A hook is a place within a 
cabinet where cores, keys, 
keyrings, and Parts are 
stored. Hooks, shelves, 
drawers, and storage 
boxes can be considered 
hooks.

To see hook information, click on the Hook card tab near the top of the 
screen.

To see keyring information, click on the Keyring card tab near the top of 
the screen.
Page 1-6 March 2007 Issue 3
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A keyring is any device 
that keys are attached to 
so they can be carried or 
stored easily.

An item’s disposition is the location of the item. The following table shows 
the possible dispositions of cores, keys, keyrings, and Parts.

This overview gives you a general sense of the ways you can use 
Keystone 600 to manage your access control system. Of course, the 
actual activities you perform using Keystone 600 and the order you 
perform them in depends on the needs of your business.

Important: Always begin using the Keystone 600 program by 
adding your Masterkey cards information first. This is 
the most important part of using the Keystone 600 
program. 

Disposition Core Key Keyring Part

issued to an employee ■ ■ ■ ■

installed in a part ■

installed in a door ■ ■

attached to a keyring ■

on a cabinet hook ■ ■ ■ ■

out of service ■ ■ ■ ■

unassigned ■ ■ ■ ■
Issue 3 March 2007 Page 1-7
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Keystone 600 
Database 
Program

Keystone 600 is a database program. A database program is a computer 
program that lets you enter information and organize it in useful ways so 
that you can ask questions and get answers about your information.

A database is a collection 
of related information 
organized to make it easy 
to search for and find 
answers to questions.

For example, suppose you needed to know which keys you issued to an 
employee and when the keys were issued. You can use Keystone 600 to 
find the answer.

In a database, a record or card is all of the information about one person, 
place, or thing. For example, an employee card contains all of the 
information about a particular employee.

Cards are made up of fields. A field is a category of information for the 
person, place, or thing described in the record. For example, on an 
Employee card, Last Name is the field that contains the employee’s last 
name. You enter information using the fields in a dialog box.

The cards show you the information about the topic you select, such as the 
number of keys issued to (held by) the employee whose name appears at 
the top of the Employee card.

User 
Permissions

A Keystone 600 Program can have many different users. Each user will 
have a unique login and unique password.

The Keystone 600 Help 
system assumes you have 
super user rights in the 
Keystone 600 Program.

Each Keystone 600 user has a set of permissions. Permissions determine 
which cards a user can view and which activities a user can perform. A 
supervisor or system administrator usually is considered a super user. A 
super user automatically has all permissions, including the ability to add 
users and select permissions for them. 

A user who issues keys to employees might have Employee and 
Transactions permissions only. This user can issue keys to employees, but 
can’t add Employee cards or key cards. Only the Employee card appears 
when this user logs into Keystone 600.

Each permission selected 
for the user has an X next 
to it.

To see a user’s permissions, click the mouse on the User card tab near 
the top of the screen.

Then click on the Permissions detail tab near the bottom of the screen, 
if not already displayed.

In this training exercise, you’ll want to access Keystone 600 as a super 
user so that you can explore all of the features provided in the system. 
Later in this manual, you’ll find out how to define user permissions.
Page 1-8 March 2007 Issue 3
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Screen Layout 
and Menus

There are four main selection areas on the Keystone 600 screen.

Notice that all main 
menu items have one 
underlined letter. If you 
press Alt and the 
underlined letter, the 
menu containing the 
underlined letter opens.

■ The main menu appears at the top of the screen. The main menu 
provides access to the Keystone 600 drop-down menu commands:

■ File
■ Edit
■ Cards
■ Commands
■ Details
■ Cross Reference
■ Help

■ The Keystone 600 card records appear in the middle of the screen. 
A card lists all of the information tracked by Keystone 600 about the 
selected person, place, or thing.

■ The quick access menus available at the bottom of the screen 
provide commands relevant for the type of card you’re viewing. The 
commands vary depending on what type of card, and which menu 
you’re viewing.

Figure 1.2 Introductory screen showing how to navigate 
Keystone 600.

Main menu

Card tabs

Detail and 
cross-reference 
tabs
Quick access 
menus
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The Regular quick access 
menu commands appear 
when none of the other 
quick access menu 
buttons appear pressed.

— The Regular quick access menu provides the commands that are 
most used, such as the F10 ‘Find a…’ command. 

— The Edit quick access menu provides the editing commands, such 
as edit and delete. Many of these commands also appear on the 
Edit drop-down menu. To view the Edit quick access menu, click 
the mouse on Edit Menu or press the Ctrl key until the button 
appears pressed. 

— The Detail quick access menu provides the quick access 
commands that let you view details about the card you are viewing. 
These commands also appear on the Details drop-down menu. To 
view the Detail quick access menu, click the mouse on Detail Menu 
or press the Shift key until the button appears pressed.

By clicking the mouse on 
the menu or pressing the 
key listed next to the 
menu name, you can view 
that menu of quick access 
commands.

Only one menu appears 
at a time. Not all of the 
menus are available for 
every type of card.

— The Cross Reference quick access menu provides the quick 
access commands that let you view cross references to the card 
you are viewing. These commands also appear on the Cross 
Reference drop-down menu. To view the Cross Reference quick 
access menu, click the mouse on Cross Reference Menu or press 
the Alt key until the button appears pressed.

To select a command from a quick access menu at the 
bottom of the screen
1 Click the mouse on the command.

2 Or press the F-key listed next to the command.

For most Keystone 600 operations, you can use the keyboard or the 
mouse. However, there are a few operations that require the mouse.

In Module 1 and Module 2, the steps include specific instructions for using 
the keyboard and mouse. These instructions help you get used to using 
both the keyboard and mouse. As you become familiar with the different 
ways you can use Keystone 600, you’ll select the methods most 
comfortable for you.

Starting in Module 3, most instructions for issuing a command tell you to 
‘Select’ the command. Detailed instructions about which keys to press or 
where to click the mouse generally are not included.

For example, a step might state “Select the Employee Card”. This means 
that you can do any of the following

■ press Alt+C, then press E

■ click the mouse on the Cards menu, then click the mouse on Employee

■ click the mouse on the Employee card tab
Page 1-10 March 2007 Issue 3



Keystone 600N5 Training Manual Module 1
Cards, Details, 
and Cross 
References

To see the detail and cross reference information tracked by the 
cards
1 Click the mouse on the Building card tab.

The information shown at the top of the card is the information, such as 
the Building’s name, you can enter to describe the building.

You enter some of the 
information tracked by 
Keystone 600. Other 
information is derived 
from the information you 
enter.

The middle section of the card lists all of the information about the 
selected detail or cross reference, such as all of the doors in the 
building. 

Near the bottom of the card is a series of detail and cross reference 
tabs that let you change the information shown in the list.

Details provide data 
directly related to the 
selected person, place, or 
thing.

2 Click the mouse on the Cores detail at the bottom of the Building card. 
The list shows the cores installed in the selected building.

3 Now click the mouse on the Doors detail. The information changes to 
show the doors in the selected building.

4 Click the mouse on the Employee card tab.

5 Click the mouse on the Keys detail at the bottom of the Employee card. 
The list shows the keys issued to the selected employee.

Cross references provide 
data indirectly related to 
the selected person, place, 
or thing.

6 Click the mouse on the Cross Ref Doors tab at the bottom of the 
Employee card. The list now shows the doors the selected employee 
can access.

Figure 1.3 Using the scroll bar to see the entire list.

Use the scroll bar to 
see 
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On your own using the Demo facility, find the card and detail or cross 
reference that shows the

■ keys held by an employee

■ buildings an employee can access

■ locks installed in a door

■ employees in a department

■ keys attached to a keyring

■ keys which operate a lock

Special Details The details and cross references that appear for each type of card vary 
from card to card. However, Keystone 600 provides some special details 
that appear on most of the cards.

Notes Detail

When there are notes for a 
selected card, the label on 
the Notes tab appears 
bracketed.

The Notes detail shows any comments entered for the selected card. You 
can add and edit notes for many types of cards. For example, view the 
Keymark notes detail.

Summary Detail

The Summary detail provides counts related to the selected card. For 
example, view the Keymark summary detail. This detail shows the count of 
coremarks related to, and keys based on, the selected keymark. It shows 
the count of buildings and doors accessed by keys based on this keymark, 
and the count of cores operated by keys based on this coremark. This 
detail also shows the count of employees and departments issued keys 
based on this keymark.

Press F2 to view the 
History detail for the next 
keymark.

History Detail

The History detail shows the records of past transactions involving the 
item described in the selected card. For example, view the Keymark 
history detail. This detail shows the history of the selected keymark. Each 
time the disposition of a key for this keymark changed, a new row was 
added to the keymark history. The history includes both the issue and 
return date for each transaction.

A key can be 

■ unassigned

■ destroyed

■ lost

■ stolen

■ issued to an employee

■ on a keyring

■ on a hook in a cabinet
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Memos Detail
Keystone 600 shows these 
G600 entries, but does not 
use them.

The Memos details are relevant only if your facility’s database is converted 
from G600 to Keystone 600. Memos details show field entries from the old 
cards that are not used for the new cards. For example, view the Keymark 
memos detail. This detail shows the G600 entries for the Keyway, Level, 
Keycut, and Description fields.

The table below shows which types of cards have these special details. 

Card Summary History Notes Memos

Building ■ ■

Cabinet ■ ■

Core ■ ■ ■

Coremark ■ ■ ■ ■

Department ■ ■

Door ■ ■ ■

Employee ■ ■ ■

Hook ■ ■ ■

Key ■ ■ ■

Keymark ■ ■ ■ ■

Facility ■ ■

Keyring ■ ■ ■

Part ■ ■ ■

Masterkey ■

Out of Service ■

Product ■ ■ ■

Reports

Site ■ ■

Unassigned ■

User ■
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Using the Help 
System

The Keystone 600 help system can assist you as you are learning about 
Keystone 600. It provides a glossary where you can look up definitions of 
words used in the program. It also provides complete instructions for 
performing an operation. When you view a help topic, you can jump to 
related topics and display pop-up boxes that contain definitions and 
examples.

You can obtain help for a specific screen. Or, you can access the entire 
help system and look for the information you want. Also, you can print one, 
more, or all Help topics.

To obtain help for a specific screen
1 Press F1 on any screen. 

Information appears describing the screen. 

2 To close the help window, select Close (press Alt+L) or click the mouse 
on the Close button.

For more information 
about how to use the help 
system, select How to 
Use Help from the Help 
menu.

To access the complete help system
1 Select the Help menu (press Alt+H or click the mouse on Help).

2 Select Help Topics (press T or click the mouse on Help Topics).

The Help Topics Contents window appears, listing the following topics

■ Learning to use Keystone 600
■ Managing an access control system
■ Managing cores, keys, keyrings, and locks
■ Managing employees and departments
■ Managing your Keystone 600 system
■ Dialog boxes and finders
■ Printing from Keystone 600

Figure 1.4 Getting context-sensitive Help.

Click the Help 
menu or simply 
press the F1 
key to get Help 
for the screen 
you’re working 
on.
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At the top of the window you also see the following tabs:

■ Contents displays the Contents screen.
■ Index displays the Index dialog box so you can locate information 

for a specific topic you select from a list or type into the Index box.
■ Find displays a series of screens that let you locate topics that 

contain specific words or phrases.

At the bottom of the Contents window, you see the following buttons:

■ Open lets you open a closed book of topics, or Close lets you 
close an opened book of topics. 

■ Print lets you print a book of related help topics or one selected 
topic. 

■ Cancel closes the Help Topics window.

You also can open a book 
by double-clicking the 
mouse on it.

A question mark (?) 
appears next to each help 
topic.

3 Click the mouse on the Learning to use Keystone 600 book. Then, 
click the mouse on Open.

The Learning to use Keystone 600 book opens.

4 Click the mouse on Close.

The Learning to use Keystone 600 book closes.

5 Click the mouse on Managing employees and departments. Then, click 
the mouse on Open.

The Managing employees and departments book opens.

6 Click the mouse on Overview: Managing employees and departments. 
Then, click the mouse on Display.

The help topic appears. The underlined words and phrases provide 
additional information or related information about the topic.

Also, you see the following buttons at the top of the screen

■ Contents displays the Contents screen.
■ Index displays the Index dialog box so you can locate information 

for a specific topic you select from a list or type into the Index box.
■ Back takes you back one-at-a-time through the help topics you 

have already viewed.
■ Print lets you print the topic you viewing.
■ Glossary displays an alphabetical listing of terms used in the help 

system. You can select a term and see its definition.
■ Close closes the help window. 

Click on a word or term 
with a dashed underline 
to view information that 
pops up on the screen.

Click on a word or term 
with a solid underline to 
jump to a related topic.

7 Click the mouse on facility.

The definition of facility appears.
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8 Click the mouse button again.

The definition of facility disappears.

9 Click the mouse on Managing employees. 

The Managing employees topic appears. From this topic you can 
explore further or you can click the mouse on Back to return to the 
previous topic.

To view the Glossary
1 Click the mouse on the Glossary button.

The Glossary screen appears. The letter buttons let you jump to a 
specific section of the glossary. For example, click on the L button to go 
to the terms beginning with the letter L appear.

To see a definition for a term, click the mouse on the term. The 
definition appears. When you click the mouse button again, the 
definition disappears.

2 Click the mouse on the Contents button.

The Contents screen appears.

To perform a search
1 Click the mouse on Index.

The Index dialog box appears.

At the bottom of the Index window, you see the following buttons:

■ Display lets you display a selected index.
■ Print lets you print a book of related help topics or one selected 

topic. 
■ Cancel closes the Help Topics window.

2 To locate topics related to an index entry, type the first word of the 
index entry. Or click the mouse on the up arrow or down arrow next to 
the index entry list to search through the list of index entries.

To double-click the 
mouse, quickly press and 
release the left mouse 
button twice.

When you locate the index entry you want, click the mouse on the 
topic. The highlight bar appears on the index entry.

For example, highlight the index entry Backing up a facility.

3 Then, click the mouse on Display. (Or, double-click the mouse on an 
index entry.)

If there’s only one relevant topic, the help window shows the topic for 
the index entry you selected.

If there’s more than one relevant topic, the Topics Found dialog box 
appears.
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4 Click the mouse on the topic you want to view. For example, click the 
mouse on Restoring a Facility Backup. The highlight bar appears on 
the topic. Then, click the mouse on Display. (Or double-click the mouse 
on the topic.)

Printing 
Keystone 600 
Help Topics

The help window shows the topic you selected.

You can print help topics from the Contents tab or from the help topic you 
are viewing in the Keystone 600 help system. For more information about 
the Contents tab, select How to Use Help from the Help drop-down menu 
at the top of the Keystone 600 screen.

To print a topic from the Contents tab
1 Click the mouse on the topic you want to print so it’s highlighted.

2 Click the mouse on the Print button at the bottom of the Contents tab.

To print all topics in a book from the Contents tab
1 Click the mouse on the book you want to print so it’s highlighted.

2 Click the mouse on the Print button at the bottom of the Contents tab.

There are over 400 topics 
in the Keystone 600 help 
system. Each of the topics 
prints on a separate page.

To print all topics in the Keystone 600 help system from the 
Contents tab

Print each of the following books:

■ Learning to use Keystone 600
■ Managing an access control system
■ Managing cores, keys, keyrings, and locks
■ Managing employees and departments
■ Managing your Keystone 600 system
■ Dialog boxes and finders

To print the topic you are viewing in the Keystone 600 help system
Click the mouse on the Print button at the top of the help window.

To exit a help topic
Select Close (press Alt+L) or click the mouse on the Close button.

To exit the Help Topics window
Select Cancel.
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On your own, use the Demo facility and 
1 Find the definition for

■ lock
■ key
■ masterkey system
■ building
■ unassigned

2 Find the following information

■ from the Help Topics Contents window, locate information about 
Managing locks

■ from Managing locks, locate information about the Cores installed 
in this lock detail

■ from the Help Topics Index window, find information about 
— Adding a Key card
— the Buildings accessed by this key detail
— the Cores installed in this lock detail
— Editing a Lock card
— Managing locks
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Installing a 
Database Using 
the Backup 
Restoral 
Feature

When you restore a backup of a facility, you copy all of the records for a 
facility from a backup file to your computer’s hard disk. You cannot merge 
data together with the restore program. The Keystone 600 program does 
have limited import and export features. Please contact Keystone 600 
Product Support for further information.

Keystone 600 can manage 
one facility (database) or 
many facilities. The 
records for each facility 
are kept separate from the 
records for other 
facilities.

We highly recommend that you contact the Keystone 600 Product Support 
Group before restoring a facility.

Logging Off 
and Exiting

The steps to log off or exit Keystone 600 are shown below. 

To log off or exit Keystone 600
When a menu is open, you 
can press the underlined 
letter in a command name 
to select a command. Or 
you can click the mouse 
on the command name.

To exit, select Exit (press 
X or click the mouse on 
Exit). Keystone 600 closes 
and the Windows desktop 
screen appears.

1 Select the File menu (press Alt+F or click the mouse on the File menu).

The File menu appears and lists all of the commands available in the 
menu.

2 Select Logoff (press L or click the mouse on Logoff). 

The Login dialog box appears so that you or someone else can login.

3 In the Name field of the Login dialog box, type BEST.

4 In the Password field, type BEST.

5 Select OK.

Module 
Review

In this module, you learned about

■ starting, logging into, logging off, and exiting Keystone 600

■ locating information tracked by Keystone 600

■ viewing the information that appears on cards, details, and cross 
references

■ using the Keystone 600 help system to learn more about how the 
program work.
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MODULE 2

Purpose of 
Module 2

The purpose of this module is to apply the concepts of cards and fields 
learned in Module 1 to 

■ create and edit basic cards

■ find, view, and print information tracked by Keystone 600

Objectives for 
Module 2

When this module is complete, you’ll be able to

■ add cards to track employees, keys, cores, and doors

■ distinguish between the fields where you

— type information

— either type information or select information from a list that you can 
maintain

Use the Demo facility for 
all exercises in this 
module.

— select information using a finder

— select information from a list provided by Keystone 600

■ maintain field entry lists to standardize information in your records and 
reduce the need to edit cards

■ update information and correct mistakes

■ find, view, and print information in your records

Overview The topics covered in this module are

■ adding cards for 

— Employees

— Keys

— Cores

— Doors

■ understanding the unassigned category for keys and cores

■ maintaining field entry lists

■ editing basic cards

■ finding, viewing, and printing cards
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Activity 1: 
Adding an 
Employee 
Card

Each Employee card provides general information about an employee. 
Before you can issue a key to an employee, or perform other activities 
involving an employee, you must create an Employee card for the 
employee.

The fields on this card are

You can enter 
information in the Type 
field and Title field. Or 
you can select the desired 
entry from the list for 
each field. We recommend 
you select an entry from a 
list whenever possible 
rather than type the 
entry.

A description of an 
employee might note the 
employee’s security 
clearance or special 
access needs. You can 
type up to 30 characters 
in the Description field.

To add an Employee card
1 Using the Demo facility, open the Cards menu (press Alt+C) and select 

Employee (press E), or click the mouse on the red Employee card tab.

2 Select Add New Employee Card (press F3 or click the mouse on Add 
New Employee Card). 

The Add Employee dialog box appears.

Field Information to enter

Last Name Employee’s last name

First Employee’s first name

MI Employee’s middle initial

ID Employee’s identification number

Dept Employee’s department

Type Category that describes the type 
of employee

Description Description of the employee

Title Employee’s job title
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To select a Department, 
click the mouse on the 
arrow next to the Dept 
field. When the 
Department finder 
appears, highlight your 
choice and select Select 
Entry (press Enter or click 
the mouse on Select 
Entry). 

You also can begin typing 
the department name. The 
highlight bar moves to 
the first entry in the list 
that matches what you 
type.

3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save and Add Another (press F6 or click the mouse on Save 
and Add Another).

6 For the next employee, complete the fields as shown below.

Notice that Keystone 600 
completes some of the 
fields for you, based on 
the previous card you 
added. You can replace 
these entries.

7 Check that the information in the fields is correct. Press F6 (Save and 
Add Another).

Field Information to enter

Last Name JONES

First GERALD

MI L

ID A63-116

Dept ACCOUNTING

Type FULL TIME

Description HAS LEVEL 2 SECURITY 
CLEARANCE

Title ANALYST 2

Field Information to enter

Last Name JAMISON

First THOMAS

MI P

ID A65-126

Dept ACCOUNTING

Type FULL TIME

Description OFTEN WORKS WEEK-
ENDS

Title ADMIN ASSISTANT
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Practice 
Activities

For practice, enter two more Employee cards.

8 Select Save (press F10 or click the mouse on Save).

Field Information to enter

Last Name YOUNG

First CARLOS

MI W

ID A22-104

Dept CHEMISTRY

Type FULL TIME

Description SOMETIMES USES THE 
BIOLOGY LAB

Title ASSOCIATE CHEMIST

Field Information to enter

Last Name HARVEY

First SUSAN

MI W

ID A11-121

Dept PUBLIC RELATIONS

Type FULL TIME

Description CONTROLS ACCESS TO 
DEPT FILES

Title SECRETARY
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Activity 2: 
Adding a 
Key Card 

Each Key card provides information about a key. 

Important: There is really no reason to add a Key Card in the 
program Keycards are automatically created when you 
issue a key to the Employee Card.

The fields on this card are:

You can type up to 
30 characters in the 
Description field.

Notice that the following fields also appear. These fields are automatically 
completed when you have added your Masterkey Card.

Field Information to enter

Keymark Keymark for the key

Key Number Number identifying the key

Product Product line the key belongs to

Description Description of the key

Field Information to enter

Level Level of a keymark in a masterkey system. 
Levels include control, grand master, master, 
submaster, and operating.

Keyway Letter or sequence of letters that indicates 
the configuration of the groove(s) along a 
key blade.

Keycut Sequence of numbers that indicates the cuts 
for a key.

Keystamp Message, name, or other words stamped on 
all keys in a particular masterkey system.

Pins Number of barrels in a core based on the 
coremark corresponding to this keymark. 
The number of barrels in a core can vary, 
although standard BEST cores have seven 
barrels.
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You also can add a Key 
card by selecting Create a 
Key from the Unassigned 
keys detail or the Keys on 
this hook detail.

To understand how pins 
relate to keys, view the 
Pin segments for this 
coremark detail. (Select 
the Coremark card and 
the Pin Segments detail.) 

Keys, cores, keyrings, and 
locks are items.

When you create a card for an item, the item initially is considered to be 
unassigned. To look up ‘unassigned’ in the glossary, follow the steps on 
the next page.

To look up a glossary term
1 Select Help (press Alt+H or click the mouse on the Help menu).

2 Select Help Topics (press T or click the mouse on Help Topics).

3 Click the mouse on Learning to use Keystone 600. Then, click the 
mouse on Open.

4 Click the mouse on Running Keystone 600. Then, click the mouse on 
Open.

5 Click the mouse on Glossary. Then, click the mouse on Display.

The Glossary screen appears. The letter buttons let you jump to a 
specific section of the glossary. 

To see a definition for a term, click the mouse on the term. The 
definition appears. When you click the mouse button again, the 
definition disappears.

6 To locate ‘unassigned’, press Page Down (or press Page Up) until you 
see ‘unassigned’ or click the mouse on the U button at the top of the 
Glossary screen to jump to the glossary terms that start with 
the letter U.

7 Select ‘unassigned’ (press the Tab key until ‘unassigned’ is highlighted 
and press Enter, or click the mouse on ‘unassigned’).

The definition of ‘unassigned’ appears.

8 Click the mouse again (or press Enter).

The definition of ‘unassigned’ disappears.

9 To exit Help, select Close (press Alt+L or click the mouse on Close).

To add a Key card

Note: Only add Key cards if you want to preload keys to the 
Unassigned Card.

1 Open the Cards menu (press Alt+C) and select Key (press Y), or click 
the mouse on the Key card tab.

To select a Keymark or a 
Product, click the mouse 
on the arrow next to the 
field. When the 
appropriate finder 
appears, select the entry 
you want.

2 Select Add New Key Card (press F3 or click the mouse on Add New 
Key Card).

A list of Keymarks is displayed. Select E1 press ENTER.

Note: A Keymark Card must already exist for the key you are adding.
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3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save (press F10 or click the mouse on Save).

The Add Items dialog box appears. 

6 Type 2, the number of keys you want to add for the selected keymark.

7 Select Save (press F10 or click the mouse on Save).

8 Select Add New Key card (press F3) A list of Keymarks is displayed. 
Select the E2 and press Enter.

If information you don’t 
want appears in a field, 
when the field is 
highlighted, press 
Backspace to delete the 
information.

9 For the next key, complete the fields as shown below.

10 Check that the information in the fields is correct.

11 Select Save (press F10 or click the mouse on Save).

The Add Items dialog box appears. 

12 Type 2 to add two keys.

13 Select Save and Add Another (F6).

Practice 
Activities

For practice, enter two more Key cards. 

Field Information to enter

Keymark E1

Key Number E1-2

Product 1A1A1

Description KEYS FOR NEW EMPLOY-
EES

Field Information to enter

Keymark E2

Key Number E2-4

Product (make this field blank)

Description KEYS FOR NEW DOOR

Field Information to enter

Keymark E2

Key Number E2-6

Product (make this field blank)

Description (leave field blank)

Add Keys 3
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14 Select Save (F10).

Activity 3: 
Adding a 
Core Card 

Each Core card provides information about a core.

Note: There is really no reason to add a Core Card in the program. 
Core Cards are automatically created when you install a core in a door.

The fields on this card are

You also can add a Core 
card by selecting Create a 
Core from the Unassigned 
cores detail or the Cores 
on this hook detail.

To enter a Coremark or a 
Product, select the 
information from the 
Coremark finder or from 
the Product finder.

A keymark and its 
corresponding coremark 
might be designated as 
DO NOT USE because of 
lost or stolen keys.

Notice that the following fields also appear. These fields are automatically 
completed when you have added your Master Key Card.

Field Information to enter

Coremark E2

Core Number E2-1

Product (make this field blank)

Field Information to enter

Coremark Coremark for the core

Core Number Number identifying the core

Product Product line the core belongs 
to

Field Information to enter

Mark Location of the core number stamped on cores 
in a particular masterkey system. “F” indicates 
face and “S” indicates side

Keyway Letter or sequence of letters that indicates the 
configuration of the groove(s) along a key blade

Status Field The status field is a note field located on the 
Keymark Card. It cannot be edited or changed 
on the Core Card.

Pin Number of barrels in a core created for the core-
mark corresponding to this keymark. The num-
ber of barrels in a core can vary, although 
standard BEST cores have seven barrels.
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To add a Core card

Note: Only add Core Cards if you want to preload cores to the 
Unassigned Card.

1 Open the Cards menu (Alt+C) and select Core (C), or click the mouse 
on the Core card tab.

2 Select Add New Core Card (press F3 or click the mouse on Add New 
Core Card).

A list of Coremarks is displayed. Select E1 press ENTER.

Note: A Core Mark Card must already exist for the core you are 
adding.

3 Complete the fields as shown below.

Note: A Core normally does not have a serial number. 

4 Check that the information in the fields is correct.

5 Select Save (press F10 or click the mouse on Save).

6 Select Add New Core Card (press F3 or click the mouse on Add New 
Core Card).

7 For the next core, complete the fields as shown below.

8 Check that the information in the fields is correct.

Field Information to enter

Coremark E1

Core Number E1

Product 1C7A1

Field Information to enter

Coremark F1

Core Number F1

Product 1C7A2
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Practice 
Activities

For practice, enter two more Core cards.

If information you don’t 
want appears in a field, 
when the field is 
highlighted, press 
Backspace to delete the 
information.

9 Select Save (press F10 or click the mouse on Save).

Field Information to enter

Coremark E2

Core Number E2

Product (make this field blank)

Field Information to enter

Coremark E2

Core Number E2

Product (make this field blank)
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Activity 4: 
Adding a 
Door Card

Doors are access points in a facility. Doors, gates, drawers and even 
padlocks can be considered doors. A door can be assigned to a building 
and to an area of a building.

Keystone 600 tracks which cores and Part/Locks are installed in each 
door. It also tracks which keys access each door, as well as which 
employees and departments have access to each door.

When you add a door to a building in a facility you are managing, you need 
to add a Door card. If information about the door changes or needs to be 
corrected, you can edit the Door card. If a door is removed from a building, 
you can delete the door card. You also can view a Door card or print a 
Door card.

Each Door card provides information about a door. Before you can install a 
core or lock in a door, or perform other activities involving a door, you must 
create a Door card for the door.

The fields on this card are

A field is empty if the 
field was left blank when 
the card for the selected 
building was created.

Notice that the Facility Zone field also appears. This field is completed 
when you add the building card. 

To add a Door card
Use the Building finder to 
select the building.

Area in the Building is a 
brief description of where 
the door is located.

For Type, select the 
category that describes 
the door. Use the 
Maintain Lists command 
in the File menu to 
maintain the Door Type 
list.

1 Open the Cards menu (Alt+C) and select Door (D), or click the mouse 
on the light blue Door card tab.

2 Select Add New Door Card (press F3 or click the mouse on Add New 
Door Card).

The Add Door dialog box appears.

3 Complete the fields as shown below.

Field Information to enter

Door Number Number to the assigned to 
the door

Area in Building Description of the area in the 
building where the door is 
located

Building Building the door is in

Description Brief description of the door

Type Type of door

Field Information to enter

Door Number 107

Area in Building ACCOUNTING

Building A102-N
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4 Check that the information in the fields is correct.

Practice 
Activities

For practice add the following Door cards.

5 Select Save (press F10 or click the mouse on Save).

Description NEXT TO PRINTER ROOM

Type GLASS

Field Information to enter

Field Information to enter

Door Number 208

Area in Building BUSINESS

Building B102-S

Description NEXT TO THE BREAK 
ROOM

Type WOOD

Field Information to enter

Door Number 209

Area in Building BUSINESS

Building B102-S

Description NEXT TO THE UTILITY 
CLOSET

Type WOOD

Field Information to enter

Door Number 210

Area in Building BUSINESS

Building B102-S

Description MAIN DOOR

Type GLASS
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Activity 5: 
Maintain-
ing Field 
Entry Lists

Some Keystone 600 fields let you select entries from a list, as well as type 
the entry. These lists help to make sure field entries are standardized. 
Standardization is especially helpful when you want to restrict a list.

If you type into a list field when you’re adding a card, the entry you type is 
added to the list for that field. However it’s safer to add entries to the list 
using the list maintenance feature.

Select an entry from a list 
whenever possible rather 
than type the entry.

To add, edit, or delete entries on a field list

1 Open the File menu (press Alt+F or click the mouse on the File menu).

2 Select Maintain Lists (press M or click the mouse on Maintain Lists).

A list maintenance box appears showing the current lists.

3 Select the list you want to change

■ Door Types
■ Employee Types
■ Employee Titles
■ Facility Zones
■ Keyways
■ Product Manufacturers

4 Now, you can

■ add an entry
■ edit an entry
■ delete an entry

To add a list entry

1 Open the File menu (press Alt+F or click the mouse on the File menu).

2 Select Maintain Lists (press M or click the mouse on Maintain Lists).

A list maintenance box appears showing the current lists.

3 Select Employee Titles (press M or click the mouse on Employee 
Title).

The Employee Titles dialog box appears.

4 Select Add (press Alt+A or click the mouse on Add).

5 Type SENIOR SCIENTIST.

6 Select OK (press Alt+O or click the mouse on OK).

SENIOR SCIENTIST appears in the list.

7 Select Done (press Alt+N on click the mouse on Done) to close the list 
maintenance box and save your change.
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Practice 
Activity

8 For practice, add two more list entries.

If the entry you want to 
delete is being used, you 
must edit the card(s) 
using the entry before you 
can delete the entry.

To delete a list entry

1 Open the File menu (press Alt+F or click the mouse on the File menu).

2 Select Maintain Lists (press M or click the mouse on Maintain Lists).

A list maintenance box appears showing the current lists.

3 Select Product Mfgs (press P or click the mouse on Product Mfgs).

The Product Manufacturers dialog box appears.

4 Select BIKE LOCKS (press the down-arrow key or the up-arrow key to 
move the highlight bar to BIKE LOCKS, or click the mouse on BIKE 
LOCKS).

If the entry you want to 
delete is being used on 
one or more cards, a box 
appears with the message 
SORRY. ENTRY IS IN 
USE.

5 Select Delete (press Alt+D or click the mouse on Delete).

BIKE LOCKS disappears from the list.

6 Select Done (press Alt+N or click the mouse on Done) to close the list 
maintenance box and save your change.

To edit a list entry

1 Open the File menu (press Alt+F or click the mouse on the File menu).

2 Select Maintain Lists (press M or click the mouse on Maintain Lists).

A list maintenance box appears showing the current lists.

3 Select Product Mfgs (press P or click the mouse on Product Mfgs).

The Product Manufacturers dialog box appears.

4 Select BEST PADLOCKS (press the down-arrow key or the up-arrow 
key to move the highlight bar to BEST PADLOCKS, or click the mouse 
on BEST PADLOCKS).

5 Select Edit (press Alt+E or click the mouse on Edit).

BEST PADLOCKS appears at the bottom of the dialog box.

6 Press the left-arrow key until the cursor is before the C in LOCKS.

7 Press the Delete key.

The C disappears and the entry is now BEST PADLOCKS.

8 Select OK (press Alt+O or click the mouse on OK).

9 Select Done (press Alt+N or click the mouse on Done) to close the list 
maintenance box and save your change.

List Information to enter

Product Mfgs BIKE LOCKS

Product Mfgs BEST PADLOCKS
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Activity 6: 
Editing 
Basic Cards

You can edit cards to correct, add, or delete information. The example 
below describes editing an Employee card. However, the steps are the 
same for all cards.

To edit an Employee card
1 Open the Cards menu (press Alt+C) and select Employee (press E), or 

click the mouse on the red Employee card tab.

1 Select Find an Employee (press F10 or click the mouse on Find an 
Employee).

The Employee finder appears listing all of the employees for this 
facility.

2 Select Dan Farrell (highlight FARRELL, DAN A. and press Enter, or 
click the mouse twice on highlight FARRELL, DAN A.).

The information about DAN FARRELL appears on the card.

3 Select the Edit menu (press Ctrl or click the mouse on Edit menu).

4 Select Edit This Employee Card (press F5 or click the mouse on Edit 
This Employee Card).

The Edit Employee dialog box appears showing the information about 
DAN FARRELL. The Dept field entry is PRODUCTION. 

Remember you must 
select the Department 
using the Department 
finder.

5 Open the Dept field and select HUMAN RESOURCES (highlight 
HUMAN RESOURCES and press Enter, or click the mouse twice on 
HUMAN RESOURCES).

6 Check that the change is correct.

7 Select Save (press F10 or click the mouse on Save).

Practice 
Activities

For practice, complete the following exercises.

Field Information to enter

Employee Find SUSAN HARVEY and change her title 
from SECRETARY to ADMIN ASSISTANT.

Key Find the E2-2 key and add a description stat-
ing “KEY FOR PROMOTED EMPLOYEE”.

Core Find the E1 core and select 5C7A1 as the 
product line for this core

Door Find the 208 door. Change the type to 
GLASS.
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Activity 7: 
Finding, 
Viewing, & 
Printing 
Cards

You can find and view information in your records on your computer 
screen. You also can print the information you are viewing if a printer is 
connected to your computer.

The following activities use the Employee card. However the way you find, 
view, and print information is the same for all cards.

You can view a card on 
the screen. However you 
can print a card when you 
want a paper copy of the 
information. You also can 
print a finder list.

To find and view information for an employee
1 Open the Cards menu (press Alt+C) and select Employee (press E), or 

click the mouse on the red Employee card tab.

2 Select Find an Employee (press F10 or click the mouse on Find an 
Employee).

The Employee finder appears listing all of the employees records for 
this facility.

3 Select GERALD JONES (highlight JONES, GERALD L or click the 
mouse on JONES, GERALD L) and select Select Entry (press Enter or 
click the mouse on Select Entry).

Information about GERALD JONES appears.

Finders help you locate information when you’re selecting an entry for a 
field or when you’re searching for a card that you want to view, edit, or 
print. 

Normally, the finder shows all of the records for the selected card type in 
your records. If there are more records than can be displayed at one time, 
you can use the scroll bar on the right of the screen to view the rest of the 
list.

Later you’ll learn how to restrict a list to limit the information you are 
viewing.

Viewing and 
Printing 
Details and 
Cross 
References

When you have located the card for a particular person, place, or thing, 
you can view and print the information in your records for the selected 
person, place, or thing. For example, the details associated with an 
Employee card show

■ Cores held by this employee (Cores)

■ Employee notes (Notes)

■ Employee summary (Summary)

■ History for items held by this employee (History)

Details provide data 
directly related to the 
selected person, place, or 
thing.

■ Items held by this employee (Items)

■ Keyrings held by this employee (Keyrings)

■ Keys held by this employee (Keys)

■ Locks held by this employee (Locks)
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Cross references provide 
data indirectly related to 
the selected person, place, 
or thing.

The cross references associated with an Employee card show

■ Buildings accessed by this employee (Cross ref Buildings)

■ Cores operated by this employee (Cross ref Cores)

■ Doors accessed by this employee (Cross ref Doors)

To view a detail

Click the mouse on the desired detail tab near the bottom of the screen. Or 
select Detail Menu (press Shift or click the mouse on Detail menu). Then 
select the detail you want (press the F-key next to the detail name or click 
the mouse on the detail name).

You can print the 
information on any detail 
or cross reference you are 
viewing by selecting 
Print ... Card. Then 
complete the appropriate 
fields and select OK.

To view a cross reference

Click the mouse on the desired cross reference tab near the bottom of the 
screen. Or select Cross Reference Menu (press Alt or click the mouse on 
the cross reference name). Then select the cross reference you want 
(press the F-key next to the cross reference name or click the mouse on 
the cross reference name).

Practice 
Activities

Practice viewing the details and cross references for Alex Black.

Notice that on every detail and cross reference, a count appears at the top. 
This count indicates the number or entries in the list.

Where can you find the answers to the following questions?

1 How many keys have been issued to Alex Black?

2 What doors can Alex Black open?

3 How many items are currently issued to Alex Black?

4 What buildings can Alex Black access?

Restricting a 
List

Suppose you want view only master keys held by employees. You can 
restrict a list to limit the information you are viewing. The restrictions you 
can place on a list vary from list to list. On the Keys held by this employee 
detail, you can restrict using the Level, Keyway, and Product 
characteristics.

You can restrict the list to 
view only entries with 
selected characteristics.
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The characteristics that 
you can restrict in a 
detail or cross reference 
have arrows next to them.

To restrict a list
1 Open the Cards menu (press Alt+C) and select Employee (press E), or 

click the mouse on the red Employee card tab.

2 Select the Keys detail (press Shift+F6 or click the mouse on the Keys 
detail tab).

The Keys held by this employee detail appears.

3 Select Level (click the mouse on the arrow next to Level).

4 Select Restrict the List to the following (press the down-arrow or click 
the mouse on Restrict the List to the following) so the button is 
selected.

5 Select M for Master (click the mouse on M).

6 Select OK (press the Tab key until OK is highlighted or click the mouse 
on OK).

If an employee doesn’t 
have a master key, the 
key count is 0 (zero).

7 Select Next Employee card (press F2 or click the mouse on Next 
Employee card) to see the next employee card.

You can select Previous Employee card (press F4 or click the mouse 
on Previous Employee card) to see the previous employee card.

The key count at the top of the detail shows the number of master keys 
held by the employee whose card you are viewing.

If you jump to another 
card, the restriction is 
canceled.

The detail shows the information about each master key held by the 
employee.

8 Repeat Step 7 to view the keys held by this employee detail for each 
employee in your records. When you reach the last employee, Next 
Employee Card appears grayed.

9 Select Level (click the mouse on Level).

10 Select List All (press the up-arrow key or click the mouse on List All).

11 Select OK (press the Tab key until OK is highlighted or click the mouse 
on OK).

The restriction is canceled and all of the keys that the employee holds 
appears on the list.
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Restricting 
Information on 
a Finder

You also can restrict the list on a finder. This is especially useful when you 
want to print a list of specific information, such as all employees in a 
department or all employees with the same title. For example, you might 
want to print a list of all employees with the job title ‘engineer’, so you can 
send them a memo.

To restrict information on a finder
1 Select Find an Employee (press F10 or click the mouse on Find an 

Employee).

You can select 
restrictions for multiple 
characteristics. You also 
can select multiple 
restrictions for a 
particular characteristic.

The Employee finder appears listing all of the employees in the records 
for this facility.

2 Click the mouse on the arrow next to Title. 

The Restrict List dialog box appears.

3 Select Restrict the List to the following (press the down-arrow key or 
click the mouse on Restrict the List to the following) so the button is 
selected.

If you no longer want a 
selected restriction, click 
the mouse on it so it is no 
longer highlighted.

4 Select ENGINEER (click the mouse on ENGINEER).

The highlight bar appears on ENGINEER.

5 Select OK (click the mouse on OK).

The finder list now shows only employees who are engineers.

When you cancel a finder, 
any restrictions to the 
finder list are canceled.

6 To print the employee list, select Print Employee list (press F8 or click 
the mouse on Print Employee list).

7 Select Cancel (press the Esc key or click the mouse on Cancel).

The finder list disappears. The restrictions are canceled.
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Sorting a List The Employee finder normally shows the list sorted by employee name. 
But you also can sort the list by employee ID. 

To sort the employee list
When you sort the list by 
employee ID, the list 
remains sorted by ID 
until you sort the list by 
name. However when you 
exit Keystone 600, the list 
is automatically resorted 
by name.

1 Select Find an Employee (press F10 or click the mouse on Find an 
Employee).

2 Select Sort by ID (press F7 or click the mouse on Sort by ID).

The list appears sorted by employee ID.

3 To see the list sorted by name again, select Sort by Name (press F7 or 
click the mouse on Sort by Name).

The list appears sorted by name.

4 Select Cancel (press the Esc key or click the mouse on Cancel).

The finder list disappears.

Using a Detail 
Finder

Detail finders let you ‘fine tune’ the restrictions for a list on a finder. From 
the finders listed below, you can select Detail Find to access a detail finder.

■ Coremark finder

■ Door finder

■ Employee finder

■ Keymark finder

When you select Detail Find from the finders listed above (at the Employee 
Card click the F10 Function Key twice), the related detail finder appears. 
The detail finder contains all of the fields that appear on the corresponding 
card. For example, the Employee detail finder contains all of the fields 
found on the Employee card.

You can type information in any of the fields. When you select Perform 
Search, the records that match the information you typed appear on the 
finder’s list. If you leave fields blank, Keystone 600 ignores those fields 
when applying your restrictions.

For example, when you select Detail Find from the Employee finder, the 
Employee detail finder appears. To restrict the list on the finder to the 
employees whose last name is Smith and who work in the Production 
department, type “SMITH” in the Last Name field. Type “PRODUCTION” in 
the Department field. Then select Perform Search.

The list on the Employee finder now shows only employees whose last 
name is Smith and who work in the Production department.
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To use a detail finder
1 Open the Cards menu (press Alt+C) and select Employee (press E), or 

click the mouse on the Employee card tab.

2 Select Find an Employee (press F10 or click the mouse on Find an 
Employee).

3 Select Detail Find (press F10 or click the mouse on Detail Find).

The Find Employee dialog box appears.

4 Type MARTIN in the Last Name field.

5 Select Perform Search (press F10 or click the mouse a second time on 
Perform Search).

The list on the Employee finder now shows only employees whose last 
name is Martin.

6 Select Cancel (press the Esc key or click the mouse on Cancel).

The detail finder list disappears.

Practice 
Activities

For practice, find the following information.

Module 
Review

In this module, you learned about

■ using the keyboard and the mouse to navigate through Keystone 600

■ adding cards to track employees, keys, cores, and doors

■ entering information in the four types of fields

■ using a finder to locate an entry for a field or a card

■ how to maintain field entry lists

■ how to restrict a list to view and print the information you want

Card Type Find this information

Doors All doors in the Shipping area 
in building B

Employee Employees whose first name 
is John
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MODULE 3

Purpose of 
Module 3

The purpose of this module is to learn about 

■ tracking common transactions

■ managing reports

Objectives for 
Module 3

When this module is complete, you’ll be able to

■ perform basic transactions

■ add cards while performing transactions

■ add and edit notes

■ define, create, customize, view, and print reports that meet your needs

■ purge reports that you no longer need

Overview The topics covered in this module are

■ issuing an item to an employee

■ transferring an item between employees

■ returning an item from an employee

■ installing a core in a door

■ removing a core from a door

■ adding cards while performing transactions

■ adding and editing notes

■ editing transactions

■ determining report needs

■ editing report constraints

■ customizing a report

■ sorting a report

■ purging a report that you no longer need
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Activity 1: 
Performing 
Basic 
Transac-
tions

Transactions are activities that change the disposition of cores, keys, 
keyrings, and locks. Transactions include

■ issuing items

■ returning items

■ transferring items

■ installing items

■ removing items

Issuing New 
Keys to 
Employees

When you want to give a key, core, keyring, or Part/lock to an employee, 
use Keystone 600 to issue the item. Then Keystone 600 can track who has 
the item and, in the case of a key or keyring, what access it provides.

To issue an existing key that is Unassigned to an employee
Before you can issue an 
existing key, the key must 
currently be unassigned 
or on a cabinet hook.

1 Find the Employee card for RUTH GARCIA.

2 Select the Keys detail, if not already displayed.

The Keys held by this employee detail shows any keys currently issued 
to RUTH GARCIA.

3 Select Issue Existing Key. (F9)

The Key finder appears, showing all keys that are in your records and 
not currently issued.

4 Highlight the E1-4 key and the E5-1 key, or any key you wish.

To issue the key today, 
don’t change the Issue 
Date field. To issue the 
key on another date, type 
that date.

If the key isn’t due on a 
certain date, leave Due 
Date blank.

If you’re not using a key 
agreement, select None.

5 Select Select Items. (ENTER)

The Issue Key dialog box appears.

6 Complete the fields as shown below.

Field Information to Enter

Issue Date Today’s date

Due Date 3/16/98

Agreement EMPLOYEE AGREEMENT

7 Select Confirm Issue. (F10)

The Keys held by this employee detail shows the keys you just issued 
to RUTH GARCIA.

8 Do not print the employee agreement.
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To issue an existing core that is unassigned to an employee
Before you can issue a 
core, the core must 
currently be unassigned 
or on a cabinet hook.

1 Find the Employee card for LARRY FREEMAN.

2 Select the Cores detail.

The Cores held by this employee detail shows any cores currently 
issued to LARRY FREEMAN.

The steps for issuing a 
lock to an employee are 
basically the same as 
issuing a core to an 
employee.

3 Select Issue existing Core. (F9)

The Core finder appears, showing all cores that are in your records 
and not currently issued.

4 Highlight any core on the list.

5 Select Select Items. (press ENTER)

The Issue Core dialog box appears.

6 Complete fields shown below.

Field Information to Enter

Issue Date Today’s date

Due Date 1/1/99

7 Select Confirm Issue. (F10)

The Cores held by this employee detail shows the core you just issued 
to LARRY FREEMAN.

Practice 
Activities

For practice, issue the following items to employees. 

1 Issue the G1-3 key to employee MARY SMITH.

2 Issue the H3 core to employee LARRY FREEMAN.
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Transferring 
Items Between 
Employees

There may be times when an employee needs a key, core, or lock currently 
issued to another employee. For example, you might transfer keys when 
an employee changes offices due to a job transfer or promotion.

To transfer a key between employees
1 Find the Employee card for RUTH GARCIA.

2 Select the Keys detail.

3 Select Transfer a Key. (Edit Menu Button + F9)

The Transfer Key Between Employees dialog box appears, showing all 
keys currently issued to RUTH GARCIA.

To locate Mary Smith, 
click the arrow next to 
the To field. Then use the 
Employee finder to locate 
Mary Smith.

The Comment field is 
limited to 15 characters.

4 Highlight a key that is on the list.

5 Complete the fields as shown below.

Field Information to Enter

To MARY I. SMITH

Transfer Date Today’s date

Due Date (leave this field blank)

Comment PROMOTION

6 Select Confirm Transfer.

To transfer a core between employees
1 Find the Employee card for LARRY FREEMAN.

2 Select the Cores detail.

3 Select Transfer a Core. (Edit Menu Button + F9)

The Transfer Core Between Employees dialog box appears, showing 
all cores currently issued to LARRY FREEMAN.

4 Highlight a core that is on the list.

5 Complete the fields as shown below.

Field Information to Enter

To THOMAS P. JAMISON

Transfer Date Today’s date

Due Date (leave this field blank)

Comment MOVED OFFICE

6 Select Confirm Transfer. (F10)
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Practice 
Activities

For practice, transfer the following items between employees. 

1 Transfer the G1-3 key from employee MARY SMITH to employee 
RUTH GARCIA.

2 Transfer the E2-1 core from employee THOMAS JAMISON to 
employee LARRY FREEMAN.

Returning 
Items From 
Employees

When an employee no longer needs a key, core, keyring, or lock, use 
Keystone 600 to return the item. Use Keystone 600 to return an item if the 
item is lost, stolen, or destroyed. You also can return the item to its prior 
location, shown in the Prior Location column on the Return Key list.

To return a key from an employee
1 Find the Employee card for RUTH GARCIA.

2 Select the Keys detail, if not already displayed.

3 Select Return a Key. (F7)

The Return Key dialog box appears, showing all keys currently issued 
to RUTH GARCIA.

4 Highlight a key RUTH GARCIA is returning.

If you select Cabinet in 
the To field, use the 
cabinet finder to select 
the cabinet you want.

Also, use the hook finder 
to select the hook in the 
cabinet.

To return an item to its 
prior location, insert a 
dot next to the prior 
location field.

5 Complete the fields as shown below.

Field Information to Enter

To CABINET

Cabinet KEY SHOP

Hook 15

Return Date Today’s date

Comment (leave this field blank)

6 Select Confirm Return. (F10)

To return a core from an employee
1 Find the Employee card for SAM ADAMS.

2 Select the Cores detail.

3 Select Return a Core. (F7)

The Return Core dialog box appears, showing all cores currently 
issued to SAM ADAMS.

4 Highlight a core SAM ADAMS is returning.
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5 Complete the fields as shown below.

Field Information to Enter

To CABINET

Cabinet KEY SHOP

Hook 23

Return Date Today’s date

Comment (leave this field blank)

6 Select Confirm Return. (F10)

Practice 
Activities

For practice, return the following items from employees.

1 Return the E5-1 key from RUTH GARCIA.

Field Information to Enter

To CABINET

Cabinet KEY SHOP

Hook 12

Return Date Today’s date

Comment TEMPORARY KEY

2 Return the H3 core from employee LARRY FREEMAN.

Field Information to Enter

To STOLEN

Return Date Today’s date

Comment (leave this field blank)
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Installing 
Items in Doors

You can install a core or a Part/lock in a door.

Installing an existing core that is unassigned in a door

When you want to install a core in a door, use Keystone 600 to install the 
core. Then Keystone 600 can track the location of the core, and who has 
access to the core and door.

Before you can install a 
core in a door, the core 
must currently be 
unassigned or on a 
cabinet hook.

You can install a lock in a 
door and then install a 
core in the lock. However, 
this is not recommended. 
We recommend installing 
both a core in the door 
and then a lock as a 
separate item.

To install a core in a door
1 Find the Door card for the door 108.

2 Select the Cores detail, if not already displayed.

The Cores installed in this door detail shows all cores currently 
installed in this door.

3 Select Install existing Core. (F9)

The Core finder appears, showing all cores that are in your records 
and available to be installed.

4 Highlight a core.

5 Select Select Items. (press ENTER)

The Install Core in Door dialog box appears.

6 Complete the Issue Date and Due Date fields with dates of your 
choice.

7 Select Confirm Install. (F10)

Removing 
Items from 
Doors

You can remove cores and locks from doors. For example, if you need to 
change a core in a door, first remove the core currently installed in the 
door. Then install the replacement core in the door.

Removing a core from a door

When you want to remove a core from a door, use Keystone 600 to remove 
the core. This way Keystone 600 can keep track of the core.

You can return the core to its prior location. The Prior Location column in 
the Remove Core dialog box shows the location of each core before it was 
installed. If a core was previously out of service or held by an employee, 
this column shows the location prior to that location.
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Keystone 600 lets you 
jump from some details 
and cross references to a 
related card.

The specific jump varies 
from detail to detail and 
from cross reference to 
cross reference, but the 
way you jump is 
generally the same.

If a jump is available, it 
appears in the center of 
the quick access menu at 
the bottom of the screen, 
next to the F6 button.

To return the core to its 
prior location, shown in 
the Prior Location 
column, don’t change the 
To field.

To assign the core to a 
hook in a cabinet, select 
Cabinet in the To field. If 
the core was lost, stolen, 
or destroyed, select the 
appropriate status. To 
leave the core unassigned, 
select Unassigned.

To remove a core from a door
1 Find the Door card for door 108.

2 Select the Cores detail, if not already displayed.

The Cores installed in this door detail shows all cores currently 
installed in the door.

3 Select Remove a Core. (F7)

The Remove Core dialog box appears, showing all cores currently 
installed in the door.

4 Highlight a core.

5 Complete the fields as shown below.

Field Information to change

To CABINET

Cabinet KEY SHOP

Hook 18

Return Date Today’s date
Comment DOOR REMOVED

6 Select Confirm Remove. (F10)

Practice 
Activities

For practice, perform the following activities.

1 Install the E4 core (installed in the Key Shop cabinet) in door 208.

Field Information to Enter

Issue Date Today’s date

Due Date 1/31/97

2 Remove the E4 core from door 208.

Field Information to Enter

To CABINET

Cabinet KEY SHOP

Hook 9

Return Date Today’s date

Comment CORE REPLACED
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Activity 2: 
Adding 
Cards while 
Performing 
Transac-
tions

Issue a new key to an employee.

To issue a new key to an employee
1 Find JANSON MARTIN, the employee you want to issue the key to.

2 Select the Keys detail.

3 Select Issue new Key. (F5)

4 Add Key + Find Keymark dialog box appears. Click on and highlight the 
F3 Keymark and press ENTER.

Note: Issuing a key to the 
Employee Card will 
automatically create a 
Key Card for you.

5 Complete the fields as shown below.

You can type up to 
30 characters in the 
Description field. Select 
the keymark from the 
Keymark finder. Select 
the Product from the 
Product finder.

Notice that the following fields also appear. These fields are 
automatically completed when you select a Keymark using the 
Keymark finder. A field is empty if the field was left blank when the card 
for the selected keymark was created.

Field Information to enter

Keymark F3

Key Number F3-3 
Note: Series No 3 is automatically 
assigned.

Product (leave this field blank)

Description (leave this field blank)

Field Information to enter

Level Security level of a key or keymark in 
a masterkey system

Keyway Letter or sequence of letters that 
indicates the configuration of the 
groove(s) along a key blade

Keycut Sequence of numbers that indicates 
the cuts for a key

Keystamp Message, name, or other words 
stamped on all keys in a particular 
masterkey system

Pins Number of barrels in a core based 
on the coremark corresponding to 
this keymark
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Levels include control, 
grand master, master, 
submaster, and operating.

The number of barrels in a 
core can vary, although 
standard BEST cores have 
seven barrels.

6 Select Save. (F10)

The Add Keys dialog box appears.

7 Enter 2, the number of keys you want to add with the selected 
Keymark.

8 Select Save. (F10)

Select the Key Agreement 
type from the Agreement 
list.

9 Complete the fields as shown below.

10 Select Confirm Issue. (F10)

The Print Key Agreement dialog box appears.

11 Select No.

The F3-3 key and the F3-4 key appear on the Keys held by this 
employee detail for JANSON MARTIN.

Practice 
Activities

For practice, perform the following operations.

1 Add a core card while issuing the core to an employee.

2 Add a core card while installing the core in a door.

Note: The above process is identical for installing a new core in a 
door, except no serial number is assigned.

Field Information to enter

Issue date Today’s date

Due date 1/1/97

Agreement Employee Agreement
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Activity 3: 
Adding and 
Editing 
Notes

Notes are any information you type about a person, place, or thing. Add 
notes to explain, clarify, or remind you about something related to the 
person, place, or thing.

Note: Notes are available on all card records.

To add a note on an employee’s card
1 Find the Employee card for RUTH GARCIA.

Remember, Keystone 600 
automatically changes 
all text you type to 
uppercase letters.

2 Select the Edit menu Button.

3 Select Edit Notes. (F6)

The Notes detail appears.

4 Type WORKS ON SUMMER WEEKENDS.

5 Select Save. (F10)

Editing Notes on a Card
■ To place the cursor in a specific location, click the mouse in the 

location. The cursor (blinking vertical bar) appears where you click the 
mouse.

■ To insert characters, place the cursor before the characters where the 
new characters should appear and begin typing.

■ To delete characters, use the

— Backspace key to delete the characters to the left of the cursor

— Delete key to delete the characters to the right of the cursor

■ To replace a word, double-click the mouse on the word. Then type the 
new word.

To edit a note on an employee’s card
1 Find the Employee card for RUTH GARCIA.

2 Select the Edit menu Button.

3 Select Edit Notes. (F6)

The Notes detail appears.

You also can double-click 
on SUMMER and type 
SOME. Then press the 
Spacebar to insert the 
space that was removed 
also.

4 Click the mouse in the space before SUMMER. 

5 Press the Delete key until SUMMER is deleted. 

6 Type SOME.

7 Select Save. (F10)
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Practice 
Activities

For practice, add or edit the following notes.

1 Add the following note to the employee DAN FARRELL.

SOMETIMES NEEDS TEMPORARY ACCESS TO LOADING DOCKS

2 Add the following note to the F6-2 key.

CREATED FOR MARY SMITH

Activity 4: 
Editing 
Transac-
tions

You can change the issue date and due date for any transaction. You might 
want to correct the issue date if you made a mistake. Or you might want to 
change, add, or remove the due date for an item.

The following instructions describe how to edit information for an issued 
key. However, you can edit the dates for any transaction.

To edit transaction information
1 Find the Door card for door 104.

2 Select the Cores detail, if not already displayed.

3 Select the Edit menu Button.

4 Select Edit Core Install. (F2)

5 Highlight a core.

6 Select Select for Edit. (press ENTER)

The Edit Issue dialog box appears.

7 Complete the fields as shown below.

Field Information to Change

Installed (do not change this field)

Due 12/31/96

8 Select Save. (F10)

Practice 
Activities

For practice, edit the following transactions.

1 Change the due date of the F3-4 key issued to JANSON MARTIN.

2 Change the install date for the E4 core installed in door 105.
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Activity 5: 
Defining 
Reports

A report is a summary of selected information in a facility’s records. 
Keystone 600 provides a variety of formatted reports, called base reports. 
However, as your reporting needs change depending on the tasks you are 
performing to manage your access control system, you may find that the 
base reports do not meet your changing needs. 

Keystone 600 lets you edit report constraints to tailor a report to suit your 
needs. You can edit constraints for a report so that only the information you 
need is included in the report. 

Also, Keystone 600 lets you customize reports. When you save a report 
format for a customized report, you add a Report card for the new report. 

You cannot purge a base 
report.

You can view a report on your computer screen or print a report on a 
printer connected to your computer. You can purge a Report card for a 
report you no longer need if the report is not a base report.

Determining 
Your Reporting 
Needs

The table below briefly describes each of the base reports you can view 
and print using Keystone 600.

This Report Shows

Building List Buildings listed in ascending order

Core History by Coremark Transactions involving installing and 
removing cores, as well as transactions 
involving issuing and returning cores, 
sorted by coremark

Core History By Door Transactions involving installing and 
removing cores, sorted by door

Core List By Building Installed cores sorted by building

Coremark List Coremarks listed in ascending order

Department List Departments listed in ascending order

Door List Doors listed in ascending order

Door List By Area Doors sorted by area

Door List By Building Doors sorted by building

Door List By Coremark Doors sorted by coremark (For each core-
mark, the cores installed in a door 
appear.)

Door List by Description Doors sorted by door description

Doors and Cores by Build-
ing

Doors and cores grouped by building

Remember, if you need a 
list of all of the cards of 
a selected type, you can 
print the list from the 
appropriate finder.

Note: A report can be 
saved to an ASCII file.

Also, remember you can 
print the information 
that appears on any 
detail or cross reference.

To print the report list, 
select Print Report List 
from the Reports finder.

Note: A report can be 
saved to an ASCII file.
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Employee List Employees listed in ascending order by 
last name

Employee List By Depart-
ment

Employees grouped by department

Employee List By Descrip-
tion

Employees sorted by description

Employee List By ID Employees sorted by employee ID

Employee List By Title Employees sorted by title

Employees With Access To 
Buildings

Employees sorted by building (For each 
building, the employees with access to the 
building appear.)

Employees With Access to 
Doors

Employees sorted by door (For each door, 
the employees with access to the door 
appear.)

Key and Keyholder By Key 
ID

Keys issued to employees sorted by key 
ID

Key and Keyholder By Key-
mark

Keys issued to employees sorted by key-
mark (For each keymark, the employees 
holding a key based on the keymark 
appear.)

Key and Keyholder By 
Serial Number

Keys issued to employees sorted by key 
serial number

Key History Transactions involving issuing keys to 
employees, transferring keys between 
employees, returning keys from employ-
ees, sorted by key

Key History By Employee Transactions involving issuing keys to 
employees, transferring keys between 
employees, returning keys from employ-
ees, sorted by employee

Keymark List By Building Keymarks sorted by building

Keymark List With Codes Keymarks listed in ascending order 
(including key codes)

Keys Due By Department Issued keys due on or before the specified 
date, sorted by department

Lost, Stolen, Or Destroyed 
Items

Out of service items sorted by item

This Report Shows
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Selecting a 
Report

To select the Employees With Access to Doors report
1 Select the Reports card.

You can use the scroll bar 
on the right of the list to 
view the rest of the list.

2 Select Find Report.

3 Highlight the Employees With Access to Doors report.

4 Select Select Entry.

The Report constraints detail shows the constraints you can use to 
define the records that will be included in the report.

5 Select Preview Report to view the Employees With Access to Doors 
report sorted by door.

6 If you have a printer connected to your computer, select Print Report to 
print the report. Then, complete the appropriate fields and select OK.

7 Select Cancel.

Editing a 
Report Card

Each Report card provides information about a base or custom report. You 
can edit the Report card to change the report’s name or description, or to 
change the orientation of the report—portrait or landscape.

Portrait means the page 
is taller than it is wide

Landscape means the 
page is wider than it is 
tall.

If you edit the Report field for a base report, the report is saved as a new 
report. The Report card for the base report is not changed.

To edit a Report card
1 Find the Key and Keyholder By Keymark Report card.

2 Select the Edit menu.

3 Select Edit This Report Card.

4 Complete the fields as shown below.

To select the orientation 
when you print the 
report, leave the 
Orientation field blank. 
Then, select the 
orientation from the print 
dialog box that appears 
when you select Print 
Report.

Field Information to Enter

Report KEY AND KEYHOLDER BY KEYMARK FOR 
1997.

Orientation Leave blank.

Description 01/01/97 THROUGH 12/31/97

5 Check that the information in the fields is correct.

6 Select Save.

7 Find the Key and Keyholder By Keymark for 1997 Report card. Also, 
notice that the original Key and Keyholder By Keymark base 
Report card appears in the finder.
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Report 
Constraints

Keystone 600 lets you edit constraints for base reports or for customized 
reports. When you edit report constraints, you can define ranges for 
selected fields to limit the information provided in the report. When you 
preview or print the report, Keystone 600 includes only the relevant cards 
that meet all of the constraints you defined.

Any fields you can 
provide constraints for 
are listed in the Field 
column on the left of the 
Report constraints detail. 
Any constraints saved for 
the report also appear on 
the Report constraints 
detail.

Only information that 
matches all of the 
constraints appears in the 
report.

When you define the constraints you want, keep in mind these guidelines

■ Keystone 600 sorts fields in ascending order when applying 
constraints—from A to Z, from lowest number to highest number, from 
earliest date to latest date.

■ If you type the same entry in the To column and in the From column for 
a field, Keystone 600 includes only information that matches that entry.

■ If you leave the From column blank and type an entry in the To column 
for a field, Keystone 600 includes all information from the beginning 
through the entry in the To column.

■ If you type an entry in the From column and leave the To column blank 
for a field, Keystone 600 includes all information from the entry in the 
From column to the end.

To edit constraints for a selected report
1 Find the Employees With Access to Doors report.

2 Select the Edit Menu.

3 Select Edit Report Constraints.

The Edit Report Constraints dialog box for this report appears. The left 
column lists the fields that you can provide constraints for.

4 Enter B100 in the From field for Doors.

5 Enter B199 in the To field for Doors.

6 Select Save.

7 To view the report on your computer screen, select Preview Report.

The report includes the B100-series doors.

8 To print the report, select Print Report. Then complete the appropriate 
fields and select OK.

9 To save the report select Save Report Format.

If you try to save changes 
to a base report, an error 
message appears stating 
“You cannot overwrite a 
Base Report.”

The Save Report Format dialog box appears.

10 Complete the fields as shown below.

Field Information to Enter

Report EMPLOYEES WITH ACCESS TO DOORS 
B100 TO B199

Orientation Leave blank.

Description BUILDING B, NORTH WING.
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11 Check that the information is correct.

12 Select Save.

Practice 
Activities

1 For practice, preview the following reports.

■ Key and Keyholder by Keymark report
■ Key and Keyholder by Serial Number report
■ Key History by Employee report
■ Keys Due by Department report

2 Edit the constraints for the report listed in each of the following 
activities and then preview the report.

■ Key and Keyholder by Keymark report. Limit the keymarks from E1 
to E6.

■ Key and Keyholder by Serial Number report. Limit the serial 
numbers from F1-1 to F6-6.

■ Key History by Employee report. Limit the employees’s last name 
from A to G.

3 Edit the constraints for Keys Due by Department report from 
PRODUCTION to PRODUCTION. Save the report as KEYS DUE BY 
PRODUCTION DEPARTMENT.
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Customizing a 
Report

Keystone 600 lets you change the format for a report and save the new 
report to use whenever you want. You can customize a report format by

■ adding and removing columns

■ rearranging columns

Any time you've made 
changes to a report 
format, Keystone 600 
prompts you to save the 
report as a new report 
when you try to leave the 
Report card for the 
report.

■ changing the way the information is sorted in the report

■ editing constraints for the report

When you preview the report, you can adjust the width of the columns to fit 
the data that appears in them. Then you can save the report format to

■ create a new report format from a base report format

■ create a new format from a report format that is not a base report 
format

■ save changes to a report format that is not a base report format

Using the Report Format detail

The Report Format detail shows the report format defined for the selected 
report.

■ The columns currently selected to be included in the report are on the 
right of the detail, in the Ordered Columns in Use List.

■ The top-most column in the Ordered Columns in Use list appears as 
the left-most column when you preview or print the report. The second 
column from the top of the list appears as the second column from the 
left in the report, and so forth.

■ The other columns that are available to be included in the report are on 
the left of the detail in the Available Columns list.

■ The numbers to the right of columns in the lists indicate the current 
sort order for the report. In other words, if <1> appears next to a 
column, the information that appears in the report first is sorted using 
this column. If <2> appears next to a column, the information next is 
sorted using this column, and so forth.

■ If “desc” appears next to a number (for example, <1 desc>), it means 
the column is sorted in descending order—from Z to A, from highest to 
lowest number, from latest date to earliest date. If only the number 
appears (for example, <1>), the column is sorted in ascending order.

You can determine which columns are to be included in the report.

■ To add a column to the report, highlight the column you want to add in 
the Available Columns list. Then select >. The column moves to the 
Ordered Columns in Use list.

■ To remove a column from the Ordered Columns in Use list, highlight 
the column you want to remove in the Ordered Columns in Use list. 
Then select <. The column moves to the Available Columns list.

Also, you can order the columns in the Ordered Columns in Use list the 
way you want them to appear in the report.
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■ To move a column up in the list (to the left in the report), highlight the 
column and select the up arrow.

■ To move a column down in the list (to the right in the report), highlight 
the column and select the down arrow.

To format a selected report
1 Find the Report card for the Employee List by Department report.

2 Select the Format detail.

The Report format detail shows the current report format.

To add all of the 
available columns to the 
report, select >>. All 
columns move to the 
Ordered Columns in Use 
list. To remove all of the 
columns from the report, 
select <<. All columns 
move to the Available 
Columns list.

3 Add Employee Type to the Ordered Columns in Use list.

4 Remove the following columns from the Ordered Columns in Use list:

■ Item Type
■ Item ID
■ Issued Date
■ Due Date

5 Order the Ordered Columns in Use list as follows:

■ Employee Name
■ Employee Title
■ Employee Type
■ Employee ID

6 Select Preview Report.

If you’re creating a new 
report by saving changes 
to a report format, type 
the new report’s name.

If you’re saving changes 
to a report format that is 
not a base report format, 
do not change the Report 
field.

7 Select Save Report Format. 

The Save Report Format dialog box appears.

8 Complete the fields as shown below.

Field Information to Enter

Report CURRENT EMPLOYEE LIST BY 
DEPARTMENT 

Orientation Leave blank.

Description (today’s date)

9 Check that the information in the fields is correct.

10 Select Save.
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Practice 
Activities

1 Find the Key History By Employee report. Format the report so that the 
new report contains the columns in the order shown below:

■ Department Name
■ Key ID
■ Issued Date
■ Returned Date
■ History Disposition

2 Save the new report as Key History by Department.

Sorting a 
Report

Keystone 600 lets you change the sort order for reports. When you change 
the sort order for a report, you select which columns should be used to 
sort the information in the report. You also select the order that the 
columns are used to sort the information.

The Report sort order detail shows the current sort order.

■ The columns currently selected to be sorted in the report are on the 
right of the detail, in the Sort Order Columns list.

■ The top-most column in the Sort Order Columns list, numbered <1>, is 
the column first used to sort the information in the report. The second 
column from the top of the list, numbered <2>, is the column next used 
to sort the information in the report, and so forth.

■ If “desc” appears next to a number (for example, <1 desc>), it means 
the column is sorted in descending order—from Z to A, from highest to 
lowest number, from latest date to earliest date. If only the number 
appears (for example, <1>), the column is sorted in ascending order.

■ The other columns that are available to be sorted in the report are on 
the left of the detail in the Available Columns list.

You can change the columns used to sort the information in the report.

■ To add a column to the Sort Order Columns list, highlight the column 
you want to add in the Available Columns list. Then select >. The 
column moves to the Sort Order Columns list.

■ To remove a column from the Sort Order Columns list, highlight the 
column you want to remove in the Sort Order Columns list. Then select 
<. The column moves to the Available Columns list.
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When you change the sort 
order for a report, 
Keystone 600 might take 
much longer to generate 
the report.

If you’re making changes 
to the Report sort order 
detail and you decide you 
want to restore the Sort 
Order Columns list to the 
way it is in the original 
base report, select Reset 
Default Sort Order.

■ To add all of the available columns to the Sort Order Columns list, 
select >>. All columns move to the Sort Order Columns list. To remove 
all of the columns from the Sort Order Columns list, select <<. All 
columns move to the Available Columns list.

Also, you can change the sort order.

■ To move a column up in the list, highlight the column and select the up 
arrow.

■ To move a column down in the list (to the right in the report), highlight 
the column and select the down arrow.

To sort a selected report
1 Find the Current Employee List By Department Report card.

2 Select the Sort order detail.

3 Remove the following columns from the Sort Order Columns list:

■ Item Type
■ Item ID

4 Add the following columns to the Sort Order Columns list:

■ Employee ID
■ Employee Title
■ Employee Type

5 Remove the Returned Date column from the Sort Order Columns list.

6 Change the sort order to the following:

■ Employee Name <1>
■ Employee Title <2>
■ Employee Type <3>
■ Employee ID <4>

7 Select Preview Report.

8 Select Save Report Format.

The Save Report Format dialog box appears.

To not overwrite the 
existing report, select No. 
Then change the report 
name in the Save Report 
Format dialog box.

9 Select Save.

A Confirmation dialog box appears stating “Overwrite existing report?”.

10 Select Yes.

The Employee List By Department and Title Report card is overwritten 
with the new sort order.
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Practice 
Activities

1 Find the Key History by Department report.

2 Sort the report in the following order: 

■ Department Name
■ Key ID
■ History Disposition
■ Issued Date
■ Returned Date

3 Save the report and name it Key History by Department and Key ID.

Purging a 
Report card

You can purge a Report card for a report you no longer need if the report is 
not a base report.

To purge a Report card
1 Find the Key History by Department and Key ID Report card. 

2 Select the Edit menu.

If you decide not to purge 
the Report card, select 
No.

3 Select Purge This Report Card.

A confirmation box appears asking, “Purge this report?”

4 To purge the Report card, select Yes.

Module 
Review

In this module, you learned about

■ performing basic transactions

■ adding cards while performing transactions

■ adding and editing notes

■ defining, creating, customizing, viewing and printing reports that meet 
your needs
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Purpose of 
Module 4

The purpose of this module is to learn about 

■ managing deleted records

■ managing departments, buildings, locks, and keyrings using 
Keystone 600

Objectives for 
Module 4

When this module is complete, you’ll be able to

■ delete cards that can be deleted

■ view, restore, and purge deleted Door cards, Employee cards, and 
Hook cards

■ add and edit cards to track information about departments, buildings, 
locks, and keyrings

■ installing and removing locks in doors

■ installing and removing cores in locks

■ attach keys to and detach keys from a keyring

Overview The topics covered in this module are

■ Managing information for cards such as

■ viewing deleted cards
■ making deleted cards active
■ purging cards that can be purged

■ Managing information for departments such as

■ viewing and printing cards
■ adding and editing cards
■ purging cards

■ Managing information for buildings such as

■ viewing and printing cards
■ adding and editing cards
■ purging cards
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■ Managing information for locks such as

■ viewing and printing cards
■ adding and editing cards
■ purging cards for out of service locks
■ issuing, returning, and transferring locks
■ installing and removing locks from doors
■ installing and removing cores from locks

■ Managing information for keyrings such as

■ viewing and printing cards
■ adding and editing cards
■ purging cards for out of service keyrings
■ attaching keys to and detaching keys from keyrings
■ issuing, returning, and transferring keyrings
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Activity 1: 
Managing 
Deleted 
Cards and 
Purging 
Cards

When you delete one of the following types of cards, the record is not 
permanently deleted at that time. You can make the deleted cards active or 
you can purge the card to remove it permanently from your records.

■ Door

■ Employee

You can permanently purge cards for out of service items, which include

■ Cores

■ Keys

■ Keyrings

■ Parts 

You can permanently purge these types of cards

■ Building

■ Cabinet

■ Coremark

■ Keymark

■ Product

■ User

Important: You cannot delete or purge these types of cards

■ Facility

■ Site

■ Masterkey

Deleting a 
Door Card

When you delete Door cards and Employee cards, the cards are saved 
even though they are no longer part of your active records. You can even 
view these types of deleted cards. Press F10 + F5. You also can make one 
of these deleted cards active again. Select REcord and press Ctrl Edit + 
F7 Undelete.

Before you can delete an 
Employee card, all items 
issued to the employee 
must be returned.

To permanently remove one of these deleted cards from your records, you 
purge the record from the history file. Select Record and press Ctrl Edit 
menu + F9 Purge.

This section will discuss deleting Door cards and managing deleted Door 
cards. The steps for deleting Employee cards and for managing deleted 
Employee cards, are basically the same.

Each Door card provides general information about a door. Before you can 
delete a Door card, all cores and Parts/locks installed in that door must be 
removed.
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To view deleted Door 
cards, see the help topic 
Viewing deleted records.

To make a deleted Door 
card active again, see the 
help topic Making a 
deleted card active. 

To delete a Door card
1 Find the Door card for door 107.

2 Select the Edit menu Button.

3 Select Delete This Door Card. (F7)

A confirmation box appears asking, “Delete this door?”

To purge a deleted Door 
card so it is completely 
removed from your 
records, see the help topic 
Purging a deleted card.

4 To delete the Door card, select OK. 

If all items installed in the door have been removed, the Door card is 
deleted. The Door card for the next door in the list appears.

If items are still installed in the door, a message appears stating, “All 
door cores and locks must be removed.” Select OK.

Practice 
Activity

For practice, delete door 108.

Viewing Deleted Records

Although deleted Door cards and Employee cards, no longer appear in 
your active door records, the deleted cards still exist in your records. You 
can view deleted Door cards and Employee cards that haven’t been 
purged. You also can view deleted Employee cards from the Department 
card and Door cards from the Building card.

To view deleted Door cards
You can view the Notes 
detail and the History 
detail for deleted cards.

1 Select the Doors card.

2 Select Find a Door. (F10)

The Door finder appears showing the active records.

3 Select Show Deleted Records. (F5)

The finder shows the deleted records.

4 If you want to view a particular deleted card, highlight the card you 
want.

5 Select Select Entry. (press ENTER)

The selected card appears.

6 To view other deleted cards, select Next Door Card (F2) or Previous 
Door Card. (F4)

Making a Deleted Card Active

You can make a deleted Door card and Employee card active again if the 
card hasn’t been purged.
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To make a deleted door card active

1 Find a Door card in the deleted door records.

2 Select the Edit menu Button.

3 Select Undelete This Door Card. (F7)

Purging a Deleted Card

You can purge a deleted Door card, Employee card, or Hook card to 
remove it permanently from your records. You can’t view purged cards.

To purge a deleted Door card

1 Find a Door card in the deleted door records.

2 Select the Edit menu Button.

3 Select Purge This Door Card. (F9)

If you decide not to purge 
the card, select Cancel.

A message appears asking, “Purge this door and all history?”

4 To purge the card, select OK.

To return to viewing active cards

1 Select Find a Door. (F10)

The Door finder appears showing the deleted records.

2 Select Show Active Records. (F5)

The finder now shows the active records. 

3 If you want to view a particular active card, highlight the card you want. 
Then, select Select Entry. (press ENTER)
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Activity 2: 
Managing 
Depart-
ments

Departments are functions of employees and not a location. For example, 
“HUMAN RESOURCES” and “MAIL ROOM” might be departments in your 
database.

Keystone 600 tracks which employees are in each department. It tracks 
which cores, keys, keyrings, and Parts/locks are issued to employees in 
each department. Keystone 600 also tracks which cores can be operated 
by employees in each department, as well as which doors and buildings 
can be accessed by employees in each department.

Finding, 
Viewing, and 
Printing 
Department 
Cards

To view the Department card for a department
1 Select the Department card.

2 Select Find a Dept. (F10)

3 Highlight PRODUCTION.

4 Select Select Entry. (press ENTER)

5 If your computer is connected to a printer, select Print Department 
Card. (F8) Then complete the appropriate fields and select OK.

To view the Department card details and cross references
You can view deleted and 
active Employee cards for 
the selected department 
when you select the 
Employee detail.

1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
1 Select the appropriate tab near the bottom of the screen.

2 Select Print Dept Card. (F8) Then complete the appropriate fields and 
select OK.

Practice 
Activities

Find the following department information.

1 Cores operated by the Production department

2 Employees in the Human Resources department

3 Keys held by the Maintenance department

Adding and 
Editing 
Department 
Cards

When you add a department for a facility you are managing, you need to 
add a Department card. If information about the department changes or 
needs to be corrected, you can edit the Department card. If a department 
is eliminated from a facility, you can purge the Department card. You also 
can view a Department card or print a Department card.
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To add a Department card
1 Select the Department card.

2 Select Add New Dept Card. (F3)

The Add Department dialog box appears.

Select the department 
from the Department 
finder.

3 Complete the fields as shown below.

You can type up to 
30 characters in the 
Description field.

4 Check that the information in the fields is correct.

5 Select Save. (F10)

To edit a Department card
1 Find the SECURITY Department card.

2 Select the Ctrl-Edit menu Button.

3 Select Edit This Dept Card. (F5)

4 Edit the fields shown below.

5 Check that the information in the fields is correct.

6 Select Save. (F10)

Practice 
Activities

1 Add the following Department cards.

Field Information to enter

Department SECURITY

Description (leave this field blank)

Field Information to enter

Department RECEPTION AND SECU-
RITY

Description REORG EFFECTIVE 1/1/95

Field Information to enter

Department MARKETING

Description INCLUDES OLD ADVERTIS-
ING DEPT

Field Information to enter

Department HOUSEKEEPING

Description (leave this field blank)
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2 Edit the RECEPTION AND SECURITY Department card. Edit the 
Description field to change the date to 1/15/97. 

3 Edit the HOUSEKEEPING Department card. Edit the Department field 
to change the department’s name to FACILITY MANAGEMENT.

4 Edit the RECEPTION AND SECURITY Department card. Edit the 
Department field to change the department’s name to SECURITY.

Purging 
Department 
Cards

You can purge a Department card when a department has been 
eliminated. Before you can purge a Department card, all of the employees 
in the department must be assigned to a different department. Or the 
cards for the employees in the department must be purged and purged by 
editing the cards for each employee assigned to the department being 
purged.

Also, before you can 
delete and purge the 
Employee cards for the 
employees assigned to the 
department, you must 
return the items assigned 
to the employees.

If you decide not to purge 
the Department card, 
select Cancel.

To purge a Department card
1 Find the SECURITY Department card.

2 Select the Ctrl Edit menu Button.

3 Select Purge This Dept Card. (F4)

A confirmation box appears asking, “Purge this department?”

4 To purge the Department card, select OK.

Practice 
Activities

For practice, perform the following activities.

1 Purge the FACILITY MANAGEMENT Department card. 

2 Purge the MARKETING Department card. 
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Activity 3: 
Managing 
Buildings

Buildings are structures in a database. A building can be assigned to a 
zone. A door can be assigned to a building and to an area in a building.

Keystone 600 tracks information about cores and locks installed in each 
building. It also tracks which departments, employees, and keys access 
each building.

Finding, 
Viewing, and 
Printing 
Building Cards

To view the Building card for a building
1 Select the Building card.

2 Select Find a Building. (F10)

3 Highlight building A.

4 Select Select Entry. (press ENTER)

5 If your computer is connected to a printer, select Print Building Card. 
(F8) Then complete the appropriate fields and select OK.

To view the Building card details and cross references
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
Select Print Building Card. Then complete the appropriate fields and 
select OK.

Practice 
Activities

Find the following building information.

1 Cores installed in the A building

2 Keys which access the A building

3 The number of cores and locks installed in the B building
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Adding and 
Editing 
Building Cards

When you add a building for a facility you are managing, you need to add a 
Building card. If information about the building changes or needs to be 
corrected, you can edit the Building card. If a building is removed from a 
facility, you can purge the Building card.

Note: You must purge all doors linked to the building before you can 
purge the Building Card.

To add a Building card
1 Select the Building card.

2 Select Add New Building Card. (F3)

The Add Building dialog box appears.

3 Complete the fields as shown below.

Type or select the zone 
the building is located in. 
For example, you might 
type ZONE 1.

Use the Maintain Lists 
command in the File 
menu to maintain the 
Facility Zones list. 4 Check that the information in the fields is correct.

5 Select Save. (F10)

To edit a Building card
1 Find the A103 building.

2 Select the Ctrl-Edit menu Button.

3 Select Edit This Building Card. (F5)

4 Change the building name from A103 to A103-N.

5 Check that the information in the field is correct.

6 Select Save. (F10)

Practice 
Activities

1 Add the following Building cards. 

Field Information to enter

Building A103

Zone NORTH COMPLEX

Description ADMINISTRATIVE ANNEX

Field Information to enter

Building A104-N

Zone NORTH COMPLEX

Description ADMINISTRATIVE ANNEX-2
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2 Edit the B102-S Building card and add the description SHIPPING AND 
RECEIVING.

Purging 
Building Cards

Each Building card provides general information about a building. You can 
purge a Building card when a building has been sold or torn down. 
However, before you can purge a Building card, you must delete and purge 
the Door cards for the doors in the building being purged.

Also, before you can 
delete and purge the Door 
cards for the doors in the 
building, you must 
remove the cores and 
locks installed in the 
doors.

If you decide not to purge 
the Building card, select 
Cancel.

To purge a Building card
1 Find the B103-S building.

2 Select the Ctrl-Edit menu Button.

3 Select Purge This Building Card. (F4)

A confirmation box appears asking, “Purge this building?”

4 To purge the Building card, select OK.

Field Information to enter

Building B103-S

Zone SOUTH COMPLEX

Description (leave this field blank)
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Activity 4: 
Managing 
Locks or 
Parts

Each Part card provides information about a Part/lock.

Note: You can purge a Part Card at any time.

For information about 
purging a Part/Lock card 
for an out of service lock, 
refer to Module 5.

A lock is a security device 
that protects a door. In a 
masterkey system, one or 
more interchangeable 
cores can be installed in a 
lock. Door locks, 
padlocks, cabinet locks, 
and other types of locks 
are considered locks.

The fields on this card are

Notice that the following fields also appear. These fields are 
automatically completed when you select a Product using the Product 
finder.

You also can add a Part/
Lock card by selecting 
Create a Part/Lock from 
the Parts/Locks on the 
hook detail.

To select a Product, use 
the Product finder.

The steps for issuing, 
returning, and 
transferring a Part/lock 
are basically the same as 
issuing, returning, and 
transferring a core. Refer 
to Module 3 for more 
information.

To add a Part card

Note: A Product Card must already exist for the Part you want to add. 
You can add multiple Part Cards for one Product Card. 

1 Select the Part card.

2 Select Add New Part Card. (F3)

The Product List appears. Highlight the 2J7D11 press ENTER

3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save. (F10) then press (F10) again.

6 Select Add New Lock Card.

Field Information to enter

Product Product line that the lock 
belongs to

Serial Part’s serial number

Description Description of the Part/lock

Manufacturer Company that makes the 
product

Number of 
Cores

Number of cores that can be 
installed in the Part/lock

Field Information to enter

Product 2J7D11

Serial Note: No serial number is 
created, however, it can be 
turned on.

Description (leave this field blank)
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7 For the next lock, complete the fields as shown below.

8 Check that the information in the fields is correct.

9 Select Save. (F10)

To edit a Part card
1 Find the 41B72 lock.

2 Select the Edit menu Button.

3 Select Edit this Lock card. (F5)

4 Add LOCK FOR STORAGE CABINET in the Description field.

5 Check that the information in the fields is correct.

6 Select Save. (F10)

Practice 
Activities

1 Add two more Lock cards.
 

2 Edit the 83T7M X S1 X 626 lock and add LOCK FOR EXTERIOR 
STORAGE for the description. 

Field Information to enter

Product 2J7D11

Serial Serial number defaults to 
Blank.

Description (leave this field blank)

Field Information to enter

Product 41B72

Serial 001

Description (leave this field blank)

Field Information to enter

Product 6S76 X 627

Serial 002

Description (leave this field blank)
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Installing 
Locks in Doors

When you want to install a lock in a door, use Keystone 600 to install the 
lock. Then Keystone 600 can track the location of the lock, and who has 
access to the lock and door.

Before you can install a 
Part/lock in a door, a 
Part card must have been 
added for that lock, and 
the Part/lock must 
currently be unassigned 
or on a cabinet hook.

To install a lock in a door
1 Find the Door card for door 108.

2 Select the Parts detail.

The Parts installed in this door detail shows all Parts/locks currently 
installed in this door.

3 Select Install existing Part. (F9)

The Install Part dialog box appears, showing all Parts/locks that are in 
your records and not currently installed.

4 Highlight the 93K7AB14D X STK X 626 lock.

5 Select Select Items. (press ENTER)

The Install Part dialog box appears.

6 Complete the Issue Date and Due Date fields with dates of your 
choice.

7 Select Confirm Install. (F10)

Note: It is recommended that cores and locks be installed separately 
in doors.

Removing 
Parts/Locks 
from Doors

You can remove Parts/locks from doors. For example, if you need to 
change a lock in a door, first remove the lock currently installed in the door. 
Then install the replacement lock in the door.

When you want to remove a Part/lock from a door, use Keystone 600 to 
remove the Part/lock. This way Keystone 600 can keep track of the Part/
lock.

You can return the Part/lock to its prior location. The Prior Location column 
in the Remove Part dialog box shows the location of each Part/lock before 
it was installed. If a Part/lock was previously out of service or held by an 
employee, this column shows the location prior to that location.
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To return the Part/lock to 
its prior location, shown 
in the Prior Location 
column, don’t change the 
To field.

To assign the Part/lock to 
a hook in a cabinet, select 
Cabinet in the To field. If 
the Part/lock was lost, 
stolen, or destroyed, 
select the appropriate 
status. To leave the lock 
unassigned, select 
Unassigned.

To remove a Part/lock from a door
1 Find the Door card for door 108.

2 Select the Parts detail.

The Locks installed in this door detail shows all Parts/locks currently 
installed in the door.

3 Select Remove a Part. (F7)

The Remove Part dialog box appears, showing all Parts/locks currently 
installed in the door.

4 Highlight a Part/lock and indicate a cabinet and hook where you want 
to store the Part/lock.

5 Select Confirm Remove. (F10)

Practice 
Activities

1 Install a 1E74 lock in door 108. 

2 Remove the 1E74 lock from door 108. 
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Activity 5: 
Managing 
Keyrings

Keyrings are devices that keys can be attached to so they can be carried 
or stored easily.

Keystone 600 tracks which keys are attached to each keyring. It also 
tracks which cores are operated by keys on each keyring, as well as which 
doors and buildings can be accessed by keys on each keyring.

Finding, 
Viewing, and 
Printing 
Keyring Cards

To view a Keyring card for a keyring
1 Select the Keyring card.

2 Select Find a Keyring. (F10)

3 Highlight keyring 21.

4 Select Select Entry. (press ENTER)

5 If your computer is connected to a printer, select Print Keyring Card. 
Then complete the appropriate fields and select OK.

The steps for issuing, 
returning, and 
transferring a keyring are 
basically the same as 
issuing, returning, and 
transferring a core. Refer 
to Module 3, Activity 1—
Performing Basic 
Transactions for more 
information.

To view the Keyring card details and cross references
1 Select the appropriate tab near the bottom of the screen. Example: 

Cross Ref Doors tab.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
4 Select Print Keyring Card. Then complete the appropriate fields and 

select OK.

Adding and 
Editing 
Keyring Cards

Each Keyring card provides information about a keyring. Before you can 
attach a key to a keyring, issue a keyring to an employee, or perform other 
activities involving a keyring, you must create a Keyring card for the 
keyring.

When you add a keyring for a facility you are managing, you need to add a 
Keyring card. If information for the keyring changes or needs to be 
corrected, you can edit the Keyring card. You also can view a Keyring card 
or print a Keyring card.
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You also can add a 
Keyring card by selecting 
Create a Keyring from the 
Unassigned keyrings 
detail or the Keyrings on 
this hook detail.

You can purge a Keyring 
card for an out of service 
keyring. For information 
about purging a card for 
an out of service item, 
refer to Module 5.

To add a Keyring card
1 Select the Keyring card.

2 Select Add New Keyring Card. (F3)

The Add Keyring dialog box appears.

3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save. (F10)

A message appears asking, “Attach keys to the new keyring?”

If you don’t want to 
attach keys, select No. 
You’ve finished adding 
the Keyring card. You can 
attach keys later.

The steps for issuing a 
keyring to an employee 
are basically the same as 
issuing a core to an 
employee. Refer to the 
section Issuing Items to 
Employees in Module 3 
for more information.

6 To attach keys, select Yes.

The Add Keyring + Attach Key dialog box appears.

7 Highlight the G1-3 key.

8 Select Select Items. (press ENTER)

9 Complete the fields as shown below

10 Select Confirm Attach. (F10)

To edit a Keyring card
1 Be at a Keyring card.

2 Select the Edit menu Button.

3 Select Edit This Keyring Card. (F5)

4 Add the description KEYRING FOR SHIPPING.

5 Check that the information in the field is correct.

6 Select Save. (F10)

Field Information to enter

Keyring ID 37

Description GARAGES 1-5

Field Information to enter

Issue Date Today’s date

Due Date (leave this field blank)
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Practice 
Activities

1 For practice, add the following Keyring cards and attach the keys 
indicated. 

Attaching Keys 
to Keyrings

You can attach keys to a keyring when you add the keyring card or later. 

Remember that before 
you can attach a key, a 
Key card must have been 
added for that key, and 
the key must currently be 
unassigned or on a 
cabinet hook.

To attach a key
1 Find a keyring.

2 Select Attach existing Key. (F9)

The Key finder appears, showing all keys that are in your records and 
available to be attached.

3 Highlight one or more keys.

4 Select Select items. (press ENTER)

The Attach Key dialog box appears.

5 Complete the fields as shown below

6 Select Confirm Attach. (F10)

Field Information to enter

Keyring ID 13

Description ADMINISTRATIVE OFFICES

Attach E1-2 key

Issue Date Today’s date

Due Date (leave this field blank)

Field Information to enter

Keyring ID 14

Description ACCOUNTING OFFICES

Attach E2-8 key

Issue Date Today’s date

Due Date (leave this field blank)

Field Information to enter

Issue Date Today’s date

Due Date (leave this field blank)
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Practice 
Activities

For practice, attach the following key to the indicated keyring.

Detaching 
Keys from 
Keyrings

When you want to detach a key from a keyring because it is no longer 
needed, use Keystone 600 to detach the key. This way Keystone 600 can 
keep track of the key.

You can return the key to its prior location. The Prior Location column in 
the Remove Core dialog box shows the location of each key before it was 
attached to the keyring. If a key was previously out of service or held by an 
employee, this column shows the location prior to that location.

To return the key to its 
prior location, shown in 
the Prior Location 
column, don’t change the 
To field.

To assign the key to a 
hook in a cabinet, select 
Cabinet in the To field. If 
the key was lost, stolen, 
or destroyed, select the 
appropriate status. To 
leave the key unassigned, 
select Unassigned.

To detach a key from a keyring
1 Find keyring 21.

2 Select Detach a Key.

The Detach Key dialog box appears, showing all keys currently 
attached to the keyring.

3 Highlight a key.

4 Complete the fields as shown below.

5 Select Confirm Detach. (F10)

Field Information to enter

Keyring ID 13

Attach E2-6 key

Issue Date Today’s date

Due Date (leave this field blank)

Field Information to enter

To CABINET

Cabinet KEY SHOP

Hook 34

Return Date Today’s date

Comment DUPLICATE KEY
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Practice 
Activities

For practice, detach the following key from the indicated keyring.

When you select Lost in 
the To field, the Cabinet 
and Hook fields are not 
available.

Practice 
Activities

To review your understanding of the topics covered in this module, 
complete the following activity.

Your company recently sold its small printing division. The Print Shop 
building and the 12 employees in the Print Shop are moving to the new 
company. What tasks do you need to perform to update your Keystone 600 
records to reflect these changes? 

List all of the tasks below in the order you need to perform them. Assume 
that there are doors in the building that have locks and cores installed. The 
locks and cores are being returned to your company. Also, assume that 
keys have been issued to the employees.

Module 
Review

In this module, you learned about

■ adding and editing cards to track information about departments, 
buildings, doors, and keyrings

■ purging department, building, and door cards

■ viewing, restoring, and purging deleted Door cards, as well as 
Employee cards and Hook cards

■ installing items in and removing items from cores, Parts/locks, and 
doors

■ attaching keys to and detaching keys from a keyring

Field Information to enter

Keyring ID 13

Detach E2-7 key

To LOST

Return Date Today’s date

Comment LOST IN S. LOT
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Purpose of 
Module 5

The purpose of this module is to learn about 

■ tracking unassigned and out of service items

■ managing information cabinets, hooks, and products

■ tracking items on hooks in cabinets

Objectives for 
Module 5

When this module is complete, you’ll be able to

■ add and edit cards to track information about unassigned items, out of 
service items, cabinets, hooks, and products

■ purge cards for out of service items

■ purge Cabinet cards, Hook cards, and Product cards

■ view, restore, and purge deleted Hook cards

■ create items on hooks

■ transfer unassigned items, out of service items, and items on cabinet 
hooks

Overview The topics covered in this module are

■ Managing information for unassigned items and out of service items 
such as

— viewing and printing cards

— transferring items

— purging cards for out of service items

■ Managing information for cabinets such as

— viewing and printing cards

— adding and editing cards

— creating cabinet hooks while adding Cabinet cards

— purging cards

■ Managing information for hooks such as

— viewing and printing cards
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— adding and editing cards

— transferring items on hooks

— creating items on hooks

— purging cards

■ Managing information for products such as

— viewing and printing cards

— adding and editing cards

— tracking items as part of a product line

— purging cards
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Activity 1: 
Managing 
Unassigned 
Items

Unassigned is a possible disposition for cores, keys, keyrings, and Parts/
locks tracked by Keystone 600. An item is considered unassigned if it is 
not 

You can view the 
Unassigned card or print 
the Unassigned card.

■ issued to an employee

■ installed in a lock or door

■ attached to a keyring

■ on a cabinet hook

■ out of service (destroyed, lost, or stolen)

You can view the History 
detail for Unassigned 
items.

When a card is created for an item, the item always is initially considered 
unassigned even if its disposition is immediately changed. You can transfer 
an unassigned item to a cabinet hook or place an unassigned item out of 
service. You also can

■ issue an unassigned item to an employee

■ attach an unassigned key to a keyring

■ install an unassigned core in a lock or a door

■ install an unassigned Part/lock in a door

Viewing and 
Printing the 
Unassigned 
Card

To view the Unassigned card details and cross references
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

3 When you’ve finished viewing the help, select Close.

To view an Unassigned card for unassigned keys
1 Select the Unassigned card.

2 Select the Keys detail.

3 If your computer is connected to a printer, select Print Card. Then 
complete the appropriate fields and select OK.

To print a detail or cross reference you’re viewing
Select Print Card. Then complete the appropriate fields and select OK.

Practice 
Activities

For practice, find the following information for unassigned items

■ unassigned cores

■ unassigned Parts/locks

■ unassigned items
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Transferring 
Unassigned 
Items

You can use Keystone 600 to transfer an unassigned item to a cabinet or 
to out of service (lost, stolen, or destroyed). This way Keystone 600 can 
keep track of the item.

To transfer an unassigned key
1 View the Unassigned card.

2 Select the Keys detail.

The Unassigned keys detail shows all currently unassigned keys.

The steps for transferring 
a core, key, keyring, or 
Part/lock are basically 
the same.

Normally, Keystone 600 
shows all items that are 
currently unassigned, out 
of service, or in a cabinet. 
But you can restrict the 
list to view only items 
with selected 
characteristics.

3 Select Transfer a Key. (F9)

The Transfer Key dialog box appears, showing all currently unassigned 
keys.

4 Highlight a key and press ENTER.

5 Complete the fields as shown below.

To assign the item to a 
hook in a cabinet, do not 
change this field. If the 
item was lost, stolen, or 
destroyed, select the 
appropriate status.

6 Select Confirm Transfer. (F10)

Field Information to enter

To DESTROYED

Cabinet (skip this field)

Hook (skip this field)

Transfer Date Today’s date

Comment (leave this field blank)
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Activity 2: 
Managing 
Out of 
Service

Out of service is a possible disposition for cores, keys, keyrings, and Parts/
locks tracked by Keystone 600. Items that are destroyed, lost, or stolen 
can be transferred to the out of service disposition. If the disposition of an 
out of service item changes, you can transfer an out of service item to a 
cabinet hook or to the unassigned disposition. You also can purge out of 
service items, if necessary.

You can view or print the 
Out of Service cards.

When a core is installed in a lock and the lock is out of service, the core is 
considered to be both installed in the lock and out of service. When a key 
is attached to a keyring and the keyring is out of service, the key is 
considered to be both attached to the keyring and out of service.

Viewing and 
Printing the 
Out of Service 
Card

To view the Out of Service card details and cross references
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

The History detail shows 
the history of cores, keys, 
keyrings, and Parts/locks 
that are currently out of 
service. Each time the 
disposition of an item 
changed to out of service, 
a new row was added to 
the item history. The 
history includes the out 
of service date for each 
transaction.

3 When you’ve finished viewing the help, select Close.

To view keys that are out of service
1 Select the Out of Service card.

2 Select the Keys detail tab.

3 If your computer is connected to a printer, select Print Card. Then 
complete the appropriate fields and select OK.

To print a detail or cross reference you’re viewing
Select Print Card. Then complete the appropriate fields and select OK.

Practice 
Activity

View the History of unassigned items detail. Restrict the list and view only 
items whose prior disposition was ‘Employee.’ Notice that the item count at 
the top of the detail changes to the number of items previously issued to 
an employee.
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Transferring 
Out of Service 
Items, Lost, 
Stolen, 
Destroyed

When you want to transfer an out of service Item that has been reported 
Lost, Stolen, or Destroyed to a cabinet/hook, or the Unassigned card, use 
Keystone 600 to transfer the item. 

To transfer an out of service key to active status

The steps for transferring 
a core, key, keyring, or 
Part/lock are basically 
the same.

1 Select the Out of Service card. 

2 Select the Keys detail.

The Keys out of service detail shows all keys currently out of service.

3 Select Transfer a Key. (F9)

The Transfer Key dialog box appears, showing all keys currently out of 
service.

4 Highlight a key and press ENTER.

5 Complete the fields as shown below.

6 Select Confirm Transfer. (F10)

Field Information to enter

To CABINET

Cabinet KEY SHOP

Hook 3

Transfer Date Today’s date

Comment FOUND 2/29/96
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Purging Lost, 
Stolen, or 
Destroyed 
Items from Out 
of Service 

You can purge Keys or other items from the Out of Service Card, if 
necessary. When you purge a lock, all cores installed in the lock are 
purged. In the same manner, when you purge a keyring, all keys attached 
to the keyring are purged. Also, the histories of items, including the 
installed or attached items are purged.

When you purge an item, 
the records of all 
transactions/history for 
the item are purged.

To purge an out of service Key and it’s card record
1 View the Out of Service card.

2 Select the Key detail

The Keys out of service detail shows all keys that are currently out of 
service.

3 Select the Ctrl-Edit menu Button.

4 Select Purge Keys. (F4)

5 Highlight a key.

6 Select Select Items. (press ENTER)

If you decide not to purge 
the Key card(s), select No.

A confirmation box appears asking, “Purge keys? Warning: This 
operation will also purge all history associated with these keys!”

7 To purge the Key card, select Yes.

Purging Key, 
Core, Part/lock 
and Keyring 
Card Records

To purge a Key Card record
1 Go to a Key card.

2 Select the Edit Menu Button.

3 Select Purge Keys. (F4)

4 A Warning box is Displayed.

5 If you wish to continue, Select YES.

The Key Card and all History on this key has been permanently 
deleted or purged.

Note: Purging Keys, Cores, Keyrings and Parts are all done the same 
way as shown above.
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Activity 3: 
Managing 
Cabinets

Cabinets are places where cores, keys, keyrings, and/or locks are stored. 
Cabinets, closets, file drawers, and other storage areas can be considered 
cabinets. 

Items within cabinets are stored on hooks. Hooks, shelves, drawers, and 
storage boxes can be considered hooks. Keystone 600 tracks which items 
are on each hook in each cabinet.

Finding, 
Viewing, and 
Printing 
Cabinet Cards

To view the Cabinet card for a cabinet
1 Select the Cabinet card.

2 Select Find a Cabinet. (F10)

3 Highlight KEY SHOP.

You can view the Notes 
detail and the Summary 
detail for Cabinet cards.

4 Select Select Entry. (press ENTER)

5 If your computer is connected to a printer, select Print Cabinet Card. 
Then complete the appropriate fields and select OK.

Normally, the Cores, 
Keys, Keyrings, Parts/
Locks, and Items details 
lists are sorted by item 
ID. But you also can sort 
the list by hook/
description. (F7) 

To view the Cabinet card details and cross references
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
Select Print Cabinet Card. Then complete the appropriate fields and 
select OK.

Practice 
Activities

Find the following cabinet information

■ cores in the Key Shop cabinet

■ items in the Key Shop cabinet

■ keys in the Key Shop cabinet
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Adding and 
Editing 
Cabinet Cards

When you add a cabinet for a facility you are managing, you need to add a 
Cabinet card. If information about the cabinet changes or needs to be 
corrected, you can edit the Cabinet card. If a cabinet is removed or 
destroyed, you can purge the Cabinet card. You also can print a Cabinet 
card. 

To add a Cabinet card
1 Select the Cabinet card.

2 Select Add New Cabinet Card. (F3)

The Add Cabinet dialog box appears.

3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save. (F10)

The Create Cabinet Hooks dialog box appears.

When you add Hook 
cards when adding a 
Cabinet card, 
Keystone 600 
automatically completes 
the fields for the Hook 
card. It completes the 
Hook field with the hook 
number and the Cabinet 
field with the cabinet 
name or number. It leaves 
the Description field 
blank. To change any of 
these fields, edit the Hook 
card.

6 To add Hook cards for the selected cabinet, complete the fields as 
shown below.

Note: The hooks are numbered consecutively, starting with the 
number 1 in the Create … Hooks for the New Cabinet field.

7 Select Save. (F10)

To edit a Cabinet card
1 Find a Cabinet card.

2 Select the Ctrl-Edit menu Button.

3 Select Edit This Cabinet Card. (F5)

4 Edit the card to add to INSIDE DOORS to the description field.

5 Check that the information in the fields is correct.

6 Select Save. (F10)

Field Information to enter

Cabinet GARAGE

Description SOUTH PARKING

Field Information to enter

Create 0 
Hooks for

The New Cabinet
Insert the correct number of 
Hooks (Example: 50)

Starting at 
Hook #1

(Don’t change this field)
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Practice 
Activities

1 Add the following Cabinet card. 

2 Find and edit the Garage Cabinet card. Edit the Cabinet field to change 
the name to GARAGE 1-SOUTH. 

Purging 
Cabinet Cards

You can purge a Cabinet card when a cabinet has been eliminated. Please 
note that all Hook Cards that are a part of the Cabinet will also be 
permanently deleted or purged.

If you decide not to purge 
the Cabinet card, select 
Cancel.

To purge a Cabinet card
1 Find a Cabinet card.

2 Select the Ctrl Edit menu Button.

3 Select Purge This Cabinet Card. (F4)

A confirmation box appears asking, “Purge this cabinet?”

4 Select YES to purge the Cabinet card and all Hooks in the Cabinet.

Field Information to enter

Cabinet FACILITY MANAGEMENT

Description HOUSEKEEPING AND 
MAINTENANCE

Hooks 20
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Activity 4: 
Managing 
Hooks

Hooks are places within cabinets where cores, keys, keyrings, and/or 
Parts/locks are stored. Hooks, shelves, drawers, and storage boxes can be 
considered hooks. Keystone 600 tracks which items are on each hook in 
each cabinet.

Finding, 
Viewing, and 
Printing Hook 
Cards

To view the Hook card for a hook
1 Select the Hook card.

2 Select Find a Hook. (F10)

3 Highlight hook 2.

4 Select Select Entry. (press ENTER)

5 If your computer is connected to a printer, select Print Hook Card. 
Then complete the appropriate fields and select OK.

You can view the Notes 
detail, the Summary 
detail and the History 
detail for Hook cards.

To view the Hook card details and cross references
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
press F1.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
Select Print Hook Card. Then complete the appropriate fields and 
select OK.

Practice 
Activities

Find the following hook information

■ number of items assigned to hook 5 in the Key Shop cabinet

■ specific items assigned to hook 2 in the Key Shop cabinet

Adding and 
Editing Hook 
Cards

When you add a hook for a facility you are managing, you need to add a 
Hook card. If information about the hook changes or needs to be 
corrected, you can edit the Hook card. If a hook is removed from a cabinet, 
you can delete then purge the Hook card. You also can print a Hook card.

To add a Hook card
1 Select the Hook card.

2 Select Add New Hook Card. (F3)

The Add Hook dialog box appears.

3 Complete the fields as shown below.

Field Information to enter

Hook 514

Cabinet Key Shop
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Type the cabinet ID or 
select the cabinet ID from 
the Hook finder.

4 Check that the information in the fields is correct.

5 Select Save. (F10)

To edit a Hook card
1 Find hook 3.

2 Select the Ctrl-Edit menu Button.

3 Select Edit This Hook Card. (F5)

4 Edit the description to be KEYS FOR MAIN ENTRANCE.

5 Check that the information in the field is correct.

6 Select Save. (F10)

Practice 
Activities

1 Add the following Hook card.

2 Edit hooks 15 in the Key Shop cabinet and change the description to 
KEYS FOR Plating Department.

Transferring 
Items on Hooks

When you want to transfer an item—key, core, keyring, or Part/lock—from 
a cabinet hook to another cabinet hook, use Keystone 600 to transfer the 
item. Also use Keystone 600 to transfer an item if the item is lost, stolen, or 
destroyed, or if you want the item to be unassigned. This way 
Keystone 600 can keep track of the item.

The steps for transferring 
a core, key, keyring, or 
Part/lock are the same.

To transfer a Key
1 Find a Hook card with a key on it.

2 Select the Keys detail.

The Keys on this hook detail shows all Keys currently on the hook.

3 Select Transfer a Key. (F9) Select a Key from the list display and press 
ENTER

The Transfer Key dialog box appears.

4 Highlight the Key.

Description (leave this field blank)

Field Information to enter

Field Information to enter

Hook 514

Cabinet Key Shop

Description (leave this field blank)
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5 Complete the fields as shown below.

6 Select Confirm Transfer. (F10)

Creating Items 
on Hooks

Keystone 600 provides the flexibility to create a Key card, Core card, Lock 
card, or Keyring card from the Hook card. 

To create a Key card from the Hook card
1 Select a hook.

2 Select the Keys detail.

3 Select Create a Key. (F5) Select the Keymark G6 and press ENTER.

The Create Key on Hook dialog box appears. 

4 Complete the fields as shown below.

5 Select Save. (F10)

The Add Keys dialog box appears.

6 Enter 1.

7 Select Save. (F10)

The Hook card reappears.

Deleting Hook 
Cards

You can delete a Hook card when a hook has been eliminated. Before you 
can delete a Hook card, you must transfer all of the items assigned to the 
hook.

To delete a Hook card
1 Find hook 1.

2 Select the Ctrl-Edit menu Button.

3 Select Purge This Hook Card. (F4)

Field Information to enter

To DESTROYED

Transfer Date Today’s date

Comment BROKEN

Field Information to enter

Keymark G6

Key Number G6-3

Product 1A1A1

Description (leave this field blank)
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A warning message appears stating, “Cannot delete this hook. All 
hook items must be returned.”

4 A Warning Message appears.

5 To delete the Hook card, select YES.

Practice 
Activities

Delete hook 11.

Viewing 
Deleted 
Records

Although deleted Employee and Door cards no longer appear in your 
active records, the deleted cards still exist in your records. You can still 
view deleted Employee and Door cards that haven’t been purged.

To view deleted Door records
You can view the Notes 
detail and the History 
detail for deleted cards.

1 Select the Door card.

2 Select Find a Door. (F10)

The Door finder appears showing the active records.

3 Select Show Deleted Records. (F5)

The finder shows the deleted records.

To view a particular deleted card
1 Highlight a Door.

2 Select Select Entry. (press ENTER)

3 To view other deleted cards, select Next Door Card (F2) or Previous 
Door Card (F4).

Making a 
deleted card 
active

You can make a deleted Door card active again if the card hasn’t been 
purged.

To make a deleted Door card active
1 Find a Deleted Door record.

2 Select the Ctrl-Edit menu Button.

3 Select Undelete This Door Card. (F7)

This Door is now active again.

Note: The above logic and instructions are identical for Deleted 
Employee records.
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Purging a 
deleted card

You can purge a deleted Door card to remove it permanently from your 
records. CAUTION: You can not view or recover purged records.

To purge a deleted Door card
1 Find a deleted door record.

2 Select the Ctrl-Edit menu Button.

3 Select Purge This Door Card.

If you decide not to purge 
the card, select Cancel.

A message appears asking, “Purge this Door and all history?”

4 To purge this card record, select YES.

This record is forever gone and can not be recovered. 

To return to viewing active cards
1 Select Find a Door. (F10)

The finder appears showing the deleted records.

2 Select Show Active Records. (F5)

The finder shows the active records. 

Important: The above logic and instructions are identical for 
Deleted Employee records.
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Activity 5: 
Managing 
Products

Products are types of cores, keys, keyrings, Parts/locks, or other items 
produced by a particular manufacturer. When you create a card for an 
item, Keystone 600 lets you track what product line the item belongs to.

Finding, 
Viewing, and 
Printing 
Product Cards

To view the Product card for a product

1 Select the Product card.

2 Select Find a Product. (F10)

3 Find the 5C7A1 Product card.

4 Select it and press ENTER.

The Product summary 
shows the count of cores, 
keys, and Parts/locks for 
the selected product line.

The Product history 
includes both the issued 
and returned date for each 
transaction.

To print a detail or cross reference you’re viewing
Select Print Product card. Then complete the appropriate fields and 
select OK.

Adding and 
Editing Product 
Cards

You can add a Product card. If information about the product changes or 
needs to be corrected, you can edit the Product card. If the product is no 
longer used, you can purge the Product card. You also can print a Product 
card.

To add a Product card

1 Select the Product card tab.

If the product line 
includes several types of 
items, select “OTHER” or 
leave this field blank.

2 Select Add New Product Card. (F3)

The Add Product dialog box appears.

3 Complete the fields as shown below.

If the product is a lock 
product, type the number 
of cores in the lock.

4 Check that the information in the fields is correct.

5 Select Save. (F10)

Field Information to enter

Product 71B723

Mfg STANLEY SECURITY 
SOLUTIONS

Type LOCK (This Field Must be 
Filled in)

Description (leave this field blank)

No. of Cores 1
Page 5-16 March 2007 Issue 3



Keystone 600N5 Training Manual Module 5
When you purge a 
Product card, all items 
belonging to the product 
line still appear in the 
database records. 
However, when you view 
the card for one of the 
items that belonged to the 
product line, the Product 
field is blank.

To edit a Product card
1 Find the 2J7D11 Product card.

2 Select the Ctrl-Edit menu Button.

3 Select Edit This Product Card. (F5)

4 Edit description field and add LARGE before TRAILER. The new 
description is LARGE TRAILER KINGPIN LOCK.

5 Check that the information in the fields is correct.

6 Select Save. (F10)

If you decide not to purge 
the Product card, select 
No.

To purge a Product card
1 Find the 71B723 Product card.

2 Select the Ctrl-Edit menu Button.

3 Select Purge This Product Card. (F4)

A confirmation box appears asking, “Purge this product? Warning: This 
operation will also disconnect all keys, cores and locks associated with 
this product!”

4 To purge the Product card, select Yes.

Practice 
Activities

1 VantagePoint is being added as a new product line. Add a Product card 
for this product. The manufacturer is STANLEY SECURITY 
SOLUTIONS and the product line includes locks and keys. Complete 
the remaining fields with information you choose.

2 1CP7WA1 is being added as a new product line. The manufacturer is 
STANLEY SECURITY SOLUTIONS and the product is a core. 
Complete the remaining fields with information you choose.

3 The manufacturer of the VantagePoint product has changed its name 
to VantagePoint S15. Edit the appropriate Product card to reflect this 
change. 

Module 
Review

In this module, you learned about

■ adding and editing cards to track information about unassigned items, 
out of service items, cabinets, hooks, and products

■ purging Cabinet cards, Hooks cards, and Product cards

■ purging cards for out of service items

■ viewing, restoring, and purging deleted Hook cards

■ creating items on hooks

■ transferring items on unassigned items, out of service items, and 
cabinet hooks
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MODULE 6

Purpose of 
Module 6

The purpose of this module is to learn about 

■ managing masterkey systems, including coremarks, and keymarks

■ using the automatic and manual pin segment calculators

■ creating work slips for building cores and cutting keys

■ adding and removing selectivity for a coremark

Objectives for 
Module 6

When this module is complete, you’ll be able to

■ find, print, and view information about masterkey systems, coremarks, 
and keymarks

■ add and edit cards to track information about masterkey systems, 
coremarks, and keymarks

■ purge cards for masterkey systems, coremarks, and keymarks

■ use the automatic pin segment calculator and manual pin segment 
calculator to find out the pin segment configuration for a coremark

■ print work slips for building cores and cutting keys

■ add and remove selectivity for a coremark

Overview The topics covered in this module are

■ Managing information for masterkey systems such as

— viewing and printing Masterkey cards

— adding Masterkey cards, Keymark cards, and Coremark cards

— editing Masterkey cards

— purging cards

■ Managing information for keymarks such as

— viewing and printing cards

— editing cards

— purging cards
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■ Managing information for coremarks such as

— viewing and printing cards

— editing cards

— purging cards

■ Using the manual and automatic pin segment calculators to find out 
the pin segment configuration for coremarks and to create work slips

■ Adding and removing selectivity for a coremark
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Activity 1: 
Managing 
Masterkey 
Systems

Masterkey systems are systems comprised of keymarks and coremarks 
that let a single key operate many cores, and also let each core be 
operated by one or many keys. A facility can have one or more masterkey 
systems. Keystone 600 tracks all of the keymarks and coremarks that 
belong to each masterkey system.

A grandmaster key is a 
key that normally 
operates all locks in a 
masterkey system. 

A control key is a key 
that inserts and removes 
cores in a masterkey 
system. A control key has 
the same security level as 
a grandmaster key.

The masterkey system code sheet detail lets you view the keymarks and 
corresponding coremarks in the selected masterkey system. The left side 
of the detail shows the relationship between all keymarks above the 
operating level. When you highlight one of these keymarks, the right side 
of the detail shows all operating level keymarks and corresponding 
coremarks in the selected keymark series.

Important: The Masterkey Card should always be added first 
when starting out on the Keystone 600 program.

The E master level keymark operates all of the operating level keymarks 
shown on the right. In other words, a key based on the E keymark can 
operate all of the cores based on the coremarks shown on the right.

When viewing the Masterkey system code sheet detail, keep in mind that 
in most masterkey systems, each operating level keymark directly 
corresponds to a coremark. Each time you add an operating level 
keymark, the corresponding coremark card record is added 
automatically.
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The diagram below shows another way to think of the relationship between 
the components of a masterkey system.

Figure 6.1 Masterkey card 

Main menu

Highlighted 
keymark

Keymarks 
above the oper-
ating level

Operating level 
keymarks and 
coremarks for 
highlighted 
keymarks
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Finding, 
Viewing, and 
Printing 
Masterkey 
Cards

To access a masterkey system
1 Using the Demo Facility, open the Cards menu (press Alt+C) and 

select Masterkey (press M), or click the mouse on the Masterkey card 
tab.

2 Select Find a Masterkey System (press F10 or click the mouse on Find 
a Masterkey System).

3 Select SYS-A (highlight SYS-A and press Enter, or click the mouse 
twice on SYS-A).

A facility can have one or 
more masterkey systems.

You can link a keymark 
or coremark directly to 
any level keymark, 
including the control 
keymark.

4 Notice that this view shows the control and grandmaster keymarks. It 
also shows the E, F, G, H, and J master level keymarks below and 
directly linked to the grandmaster.

Figure 6.2 Diagram showing a sample hierarchical view of the 
masterkeying relationships.

Control Keymark

M

OP

OP

Masterkey System

Grandmaster Keymark

M M

SM SM OP

OP OPOP

OP
SM
M = Master level keymark

= Submaster level keymark
= Operating level keymark
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For an explanation of the 
detail you’re viewing, 
select Help (press F1 or 
click the mouse on Help).

When you’ve finished 
viewing the help, select 
Close (press Alt+L or 
click the mouse on Close).

To view the Masterkey system code sheet detail
1 Click the mouse on the F keymark.

The right half of the Code sheet detail changes to show the operating 
level keymarks and corresponding coremarks under the F master level 
keymark.

Remember that the F master level keymark operates all of the 
coremarks shown on the right. The grandmaster level keymark 
operates all coremarks under all master level keymarks.

2 Click the mouse on the H keymark.

The right half of the Code sheet detail changes to show the operating 
level keymarks and corresponding coremarks under the H master level 
keymark.

Figure 6.3 Screen showing the F Keymarks

Highlighted 
keymark
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Practice 
Activities

Find the following masterkey system information.

■ How many master level keymarks are there in the SYS-A masterkey 
system?

■ How many operating level keymarks are there in the F keymark series?

■ What coremarks does the J keymark operate?

Adding and 
Editing a 
Masterkey 
Card, 
Grandmaster 
Keymark Card, 
and Control 
Keymark Card

When you add a masterkey system for a facility you are managing, you 
need to add a Masterkey card. Never use the non-system Masterkey Card 
for adding Keymarks and Coremarks.

The fields on this card are

Figure 6.4 Screen showing the H Keymarks

Highlighted 
keymark

Field Information to enter

System Sequence of letters such as “Best” that iden-
tifies the masterkey system.

System Type System type for the masterkey system. If the 
system isn’t an A2, A3, or A4 system, select 
“OTHER”.

Pins Number of barrels in the cores belonging to 
the masterkey system.
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If information about the 
masterkey system 
changes or needs to be 
corrected, you can edit 
the Masterkey card.

When you add the Masterkey system, you must also add the Keymark 
cards for the system’s grandmaster keymark and control keymark. 

3 The fields on these Keymark cards are 

Make sure you select the 
correct level for a 
keymark. 

Keyway Letter or sequence of letters that indicates 
the configuration of the groove(s) along the 
key blade of all keys belonging to the mas-
terkey system.

Mark Location of the core number stamped on 
cores belonging to the masterkey system. 
“F” indicates face and “S” indicates side.

Keystamp Message, name, or other words stamped on 
one or both sides of the key.

Field Information to enter

Field Information to enter

Keymark Sequence of letters and numbers that indi-
rectly corresponds to a keycut pattern for a 
key or group of keys that operates one or 
more specific cores or locks.

Level Security level of a key or keymark in a mas-
terkey system. Levels include control, grand-
master, master, submaster, and operating.

Keycut Sequence of numbers indicating the cuts for 
a key. The terms keycut and code are used 
interchangeably.

System Sequence of letters and/or numbers that 
identifies the masterkey system.

System Type System type for the masterkey system.

Keyway Letter or sequence of letters that indicates 
the configuration of the groove(s) along the 
key blade of all keys belonging to the mas-
terkey system.

Pins Number of barrels in the cores belonging to 
the masterkey system.

Keystamp Message, name, or other words stamped on 
keys.
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To add the Masterkey card, for a masterkey system
1 Open the Cards menu (press Alt+C) and select Masterkey (press M), 

or click the mouse on the Masterkey card tab.

2 Select Add New Masterkey Card (press F3 or click the mouse on Add 
New Masterkey Card).

The Add Masterkey System dialog box appears.

If the system type isn’t an 
A2, A3, or A4 system, in 
other words, a non-BEST 
keying system, select 
“OTHER”.

You must add the 
grandmaster Keymark 
and the control Keymark 
when you add the 
Masterkey system card.

3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save (press F10 or click the mouse on Save).

A message appears asking, “Create grandmaster keymark for the new 
masterkey system?”

6 Select Yes.

Note: ALWAYS say YES to the Grandmaster.

The Create Grandmaster Keymark dialog box appears.

7 Complete the fields as shown below.

The fields on the Control 
Keymark card are the 
same as the fields on the 
Grandmaster Keymark 
card.

Notice that the following fields also appear. These fields are 
automatically completed when you create the Masterkey card.

Field Information to enter

System SYS-B

System Type A2

Pins 7

Keyway A

Mark S

Keystamp 279X292

Field Information to enter

Keymark GRANDMASTER1

Level (This field defaults to GM)

Keycut 4711608

System Masterkey system

System Type Type of masterkey system, such as A2

Keyway Letter or sequence of letters that indicates 
the configuration of the groove(s) along the 
key blade of all keys belonging to the mas-
terkey system.
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8 Check that the information in the fields is correct.

9 Select Save (press F10 or click the mouse on Save).

A message appears asking, “Create control keymark for the new 
masterkey system?”

10 Select Yes.

Note: Only select YES for BEST and other removable core systems.

The Create Control Keymark dialog box appears.

11 Complete the fields as shown below.

12 Check that the information in the fields is correct.

13 Select Save (press F10 or click the mouse on Save).

The structure of the SYS-B masterkey system should appear as shown 
on the next page.

Pins Number of barrels in the cores belonging to 
the masterkey system

Keystamp Message, name, or other words stamped on 
all keys in a particular masterkey system.

Field Information to enter

Keymark CONTROL1

Level CONTROL (This field 
defaults to Control)

Keycut 2597826

System Masterkey system
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To edit a Masterkey card

Important: Check with the Keystone 600 Support Group before 
editing the Masterkey Card.

1 Select Find a masterkey system (press F10 or click the mouse on Find 
a Masterkey System).

2 Highlight SYS-A and select Select Entry (press Enter, or click the 
mouse on Select Entry).

3 Select the Edit menu (press Ctrl or click the mouse on Edit Menu).

4 Select Edit This Masterkey Card (press F5 or click the mouse on Edit 
This Masterkey Card).

5 Edit the field as shown below.

6 Check that the information in the field is correct.

7 Select Save (press F10 or click the mouse on Save).

Figure 6.5 Screen showing the structure of the SYS-B masterkey 
system

Field Information to change

Mark S
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Purging a 
Masterkey 
Card

Each Masterkey card provides information about a masterkey system. 
You can not purge or delete a Masterkey card after it has been 
created, or when a masterkey system has been eliminated. Please 
check with Keystone 600 Support Group for further details.

Using the 
Masterkey 
System Code 
Sheets

When you get the codes for your masterkey system from STANLEY 
SECURITY SOLUTIONS, you get a series of code sheets. Each code 
sheet shows the control keymark code, the grandmaster keymark code, 
the master level keymark code, and possibly the submaster level keymark 
code, as well as the operating level keymark codes for a keymark series. 
An example of the structure of a code sheet is shown below.

A masterkey system 
might or might not have 
submaster level keymarks 
under a masterkey. 
Submaster level 
keymarks also can have 
sub-submaster level 
keymarks, depending on 
the structure of your 
masterkey system.

When reading BEST code sheets, remember that the letters (and 
numbers) designating a keymark or coremark indicate the series to which 
the keymark or coremark belongs. For example, the 1BB submaster level 
keymark listed below is part of the 1B keymark series. The 1BB1 coremark 
shown in the code sheet is operated by the 1BB submaster keymark, the 
1B keymark and the grandmaster keymark.

You are going to transfer information from the code sheet to the 
Keystone 600 system. 

Figure 6.6 Fragment of the 1BB submaster level code sheet
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The following figure shows how the code sheet relates to the Masterkey 
system code sheet detail.

Figure 6.7 Mapping between the masterkey code sheet and Keystone 
600 code sheet 
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Adding Master 
and Submaster 
Level 
Keymarks

After you add a Masterkey Card, the grandmaster keymark, and the 
control keymark, add ALL master level and submaster level keymarks for 
the system next. See Instructions below.

The first step is to add all master and sub master keymarks. The structure 
of the masterkey system above the operating level will be complete. Then 
you can add the operating level keymarks and corresponding coremarks 
under each master level or submaster level keymark.

Keymarks are sequences 
of letters and numbers 
that directly correspond 
to a keycut pattern for a 
key or group of keys that 
operates a particular core 
or lock in a masterkey 
system. When you add a 
key for a facility, the key 
is based on a selected 
keymark.

You can link a keymark 
or coremark directly to 
any level keymark, 
including the control 
keymark.

If you add a SSM, most of 
the code is completed for 
you.

When you are adding keymarks for the masterkey system, it is very 
important to select the correct series for each keymark. The keymark you 
select in the Series field should be the keymark immediately above the 
keymark you are adding.

There are only 2 steps in adding Keymarks and Coremarks:

Step 1 Click on or highlight the Keymark that is one level higher than the 
one you are creating or adding.

Step 2 Select (F7) if you are adding a Master level, sub master, or sub sub 
master keymark.

Select (F9) if you are adding a operating or (The lowest level) 
Keymark and Coremark. In other words a keymark that is not a 
master level.

Caution: Never add Keymarks or Coremarks from the Keymark Card 
or Coremark card itself. Linkages and connections will be 
incorrect if you do.

To add a master level keymark
1 From the Masterkey system Code sheet detail with SYS-B selected, 

highlight the GRANDMASTER1 keymark (press the up or down arrow 
key or click the mouse on GRANDMASTER1). This is STEP 1 as 
shown above.

1 STEP 2 is next.

2 Select Add Master Level Keymark. (F7) 

3 To add the 1B master level keymark and to link it directly to the 
grandmaster keymark, complete the fields as shown below.

Field Information to enter

Keymark 1B

Level M (Already Filled in for you)

Series GRANDMASTER1(Already 
Filled in)

Keycut 6971608

Status Optional Field (Not needed)
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4 Check that the information, especially, the Key cut. 

5 Select Save (press F10 or click the mouse on Save).

To add a submaster level keymark
1 With the SYS-B Masterkey System displayed, highlight the 1B keymark 

(press the up or down arrow key or click the mouse on 1B).

This is STEP 1 as shown above.

STEP 2 is next:

2 Select Add Master Level Keymark. (F7) 

3 To add the 1BB submaster level keymark and to link it to the 1B 
keymark, complete the fields as shown below.

4 Check that the information is correct.

5 Select Save (press F10 or click the mouse on Save).

Operating 
Level 
Keymarks and 
Corresponding 
Coremarks

After you’ve added all of the master level keymarks above the operating 
level for the masterkey system, you are ready to add the operating level 
keymarks and corresponding coremarks. Again, it’s very important when 
you enter this information to make sure each keymark and coremark is in 
the correct keymark series. If this information is not complete and correct, 
the automatic pin segment calculator will not operate properly.

Remember: Follow the 2 step process as outlined on page 6-14.

To add an operating level Keymark and corresponding Coremark
Coremarks are sequences 
of letters and numbers 
that directly correspond 
to a pin segment 
configuration for a core in 
a masterkey system. 

When you add a core for a 
facility, the core is based 
on a selected coremark.

1 On the left side of the masterkey system Code sheet detail, highlight 
the master level keymark that is immediately above the coremarks/
keymarks that you want to add. For this exercise, highlight the 1BB 
submaster level keymark (press the up or down arrow key or click the 
mouse on 1BB). This is STEP 1

STEP 2:

2 Select Add OP Keymark/Coremark. (F9) 

The Add Coremark window appears at the bottom of the right side of 
the detail, as shown below. The submaster level keymark automatically 

Field Information to enter

Keymark 1BB

Level SM (Already filled in for you)

Series 1B (Already filled in for you)

Keycut 6979608

Status Optional field (Not needed)
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appears in the Keymark/Coremark field so that you only have to enter 
the number for the coremark. 

Note: This is not a key serial number.

Also, Keystone 600 automatically completes the first part of the 
keymark/coremark you are adding and its code, based on the 
highlighted submaster keymark.

If you enter the incorrect 
code, edit the keymark 
card and correct the 
Keycut field. 

3 Type 1, the remainder of the 1BB1 keymark/coremark, the first 
operating level keymark/coremark for the 1BB keymark.

4 Press Tab so the cursor moves to the Code field. Then type 820, the 
remainder of the code for the 1BB1 keymark/coremark.

If you make a mistake 
entering the Coremark 
information, select the 
Coremark card and find 
the Coremark that is 
incorrect. Then edit the 
Coremark information 

The code should appear as 6979802, as shown on the next page. The 
keymark/coremark is added to the right side of the detail. Its status 
automatically is assigned as in use.

5 Select Save and Add Another (press F6 or click the mouse on Save 
and Add Another).

Save (F10) saves quits 
this operation. Save and 
Add Another (F6) saves 
the current coremark and 
lets you add another 
coremark under the 
highlighted keymark.

The Add Coremark window appears, as shown on the next page. 

Figure 6.8 Screen showing how Keystone 600 completes the first part 
of the keymark or coremark

Keystone 600 
partially com-
pletes the key-
mark/coremark
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6 Using the code sheet below, add the next three operating level 
keymarks and corresponding coremarks under the 1BB submaster 
level keymark.

7 After each entry, check that the information is correct, then select Save 
and Add Another to add the next operating level keymark and 
corresponding coremark.

8 When you have entered the 1BB4 keymark and corresponding 
coremark, select Save (press F10 or click the mouse on Save).

Figure 6.9 Screen showing the add coremark window

Add coremark 
window

Figure 6.10 Fragment of the 1BB submaster level code sheet
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Using Set 
Series

If you selected the incorrect series for a keymark (STEP 1), or if you want 
to change the series to which a keymark is assigned, use Set Series to 
assign the keymark to the correct series.

Important: Do not do the following procedure without contacting 
Keystone 600 Support Group.

To set a series for a keymark

For practice, enter a master level keymark under the incorrect submaster 
level keymark. Follow the steps below.

1 With the SYS-B masterkey system selected, highlight the 1BB 
keymark.

2 Select the Edit menu (press Ctrl so that the button appears pressed or 
click the mouse on Edit Menu).

3 Select Add Keymark (press F7 or click the mouse on Add Keymark).

4 Complete the fields as shown below.

5 Select Save (press F10 or click the mouse on Save).

The 1BC keymark appears on the left side of the detail, linked to the 
1BB keymark.

The sub-sub master level keymark 1BC should really be under 1B, not 
under 1BB as we entered it. To change the series for the keymark, follow 
the steps below.

1 Highlight 1B (press the up or down arrow key or click the mouse on 
1B). 

2 Select the Edit Menu (press Ctrl so that the button appears pressed or 
click the mouse on Edit Menu).

3 Select Set Series (press F8 or click the mouse on Set Series).

The Keymark list appears.

4 Highlight the 1BC keymark (press the up or down arrow key or click the 
mouse on the 1BC keymark).

Field Information to enter

Keymark 1BC

Level SSM

Series 1BB

Keycut 1234567

Status IN USE
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5 Select Save Series (press F10 or click the mouse on Save Series).

A message appears asking, “Save series for selected keymarks?”

6 Select Yes (click the mouse on Yes).

The 1BC keymark now appears linked to the 1B keymark.
Issue 3 March 2007 Page 6-19



Module 6 Keystone 600N5 Training Manual
Activity 2: 
Managing 
Keymarks

Keystone 600 tracks which keys are based on each keymark, which 
coremarks are related to each keymark, and which cores are based on 
coremarks related to each keymark. Keystone 600 also tracks which doors 
and buildings are accessed by keys based on each keymark, and which 
employees and departments hold keys based on each keymark.

If information about a keymark changes or needs to be corrected, you can 
edit the Keymark card.

Finding, 
Viewing, and 
Printing 
Keymarks

To view a Keymark card 
1 Open the Cards menu (press Alt+C) and select Keymark (press A), or 

click the mouse on the Keymark card tab.

2 Select Find a Keymark card (press F10 or click the mouse on Find a 
Keymark card).

3 Highlight the 1BB3 keymark (press the up or down arrow key or click 
the mouse on the 1BB3 keymark).

4 Select Select Entry (press Enter or click the mouse on Select Entry.)

Keymark history shows 
the history of keys based 
on the selected keymark. 

Keymark summary shows 
the count of coremarks 
related to, and keys based 
on, the selected keymark. 
It shows the count of 
buildings and doors 
accessed by keys based on 
this keymark, and the 
count of cores operated 
by keys based on this 
coremark. This detail 
also shows the count of 
employees and 
departments issued keys 
based on this keymark.

To view the Keymark card details and cross references
1 Click the mouse on the desired tab near the bottom of the screen. Or 

select the Detail menu (press Shift) and select the detail you want 
(press the F-key next to the detail name).

2 For an explanation of the detail you’re viewing, select Help (press F1 or 
click the mouse on Help).

3 When you’ve finished viewing the help, select Close (press Alt+L or 
click the mouse on Close).

To print a detail or cross reference you’re viewing
Select Print Keymark Card (press F8 or click the mouse on Print 
Keymark Card). Then complete the appropriate fields and select OK.
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Adding, 
Editing, and 
Purging a 
Keymark Card

If information about a keymark changes or needs to be corrected, you can 
edit the Keymark card. You can purge a Keymark card if you created it by 
mistake.

Before you can add or 
issue a key, a Keymark 
card for must have ben 
created at the Master Key 
Card screen. 

Never select “Non-
System” as the level.

To add a Keymark card

Always, add Keymarks from the Masterkey Card using the 2 Step process 
outlined on pages 6-13 and 6-14 and never from the Keymark card itself.

To edit a Keymark card
1 Find a keymark.

2 Select the Edit menu (press Ctrl or click the mouse on Edit Menu).

3 Select Edit This Keymark Card (press F5 or click the mouse on Edit 
this Keymark).

4 Edit the field as shown below.

5 Check that the information in the field is correct.

6 Select Save (press F10 or click the mouse on Save).

When you purge a 
Keymark card, all Key 
cards for keys based on 
the keymark will also be 
purged, along with any 
history on the keys.

If you decide not to purge 
the Keymark card, select 
No.

To purge a Keymark card
1 Find a keymark.

2 Select the Ctrl-Edit menu Button. 

3 Select Purge This Keymark Card. (F4) 

A confirmation box appears asking, “Purge this keymark? Warning: 
This operation will also disconnect all keymarks and coremarks 
associated with this keymark!”

4 Select Yes.

Caution: Purging a Keymark will also delete or purge any 
connected keys and their history.

Field Information to change

Status NOT USED
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Activity 3: 
Managing 
Coremarks

Keystone 600 tracks which cores are based on each coremark, and which 
keys operate cores based on each coremark. Keystone 600 also tracks 
which doors and buildings have cores based on each coremark, and which 
employees and departments have access to cores based on each 
coremark.

Finding, 
Viewing, and 
Printing 
Coremark 
Cards

To view the Coremark card for a coremark
1 Open the Cards menu (press Alt+C) and select Coremark (press K), or 

click the mouse on the Coremark card tab.

2 Select Find a Coremark (press F10 or click the mouse on Find a 
Coremark Card).

3 Highlight the 1BB4 coremark (click the mouse on the 1BB4 coremark).

4 Select Select Entry. (press Enter)

Coremark history shows 
the history of cores based 
on the selected coremark.

Coremark summary 
shows the count of cores 
based on the selected 
coremark, and the count 
of keys that operate cores 
based on the selected 
coremark. It shows the 
count of doors with 
installed cores based on 
the selected coremark. It 
also shows the count of 
employees and 
departments with access 
to cores based on the 
selected coremark.

To view the Coremark card details and cross references
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail or cross reference you’re viewing, 
select Help.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
Select Print Coremark Card. Then complete the appropriate fields and 
select OK.

Practice 
Activities

Find the following coremark information

■ find the keymarks that operate the E2 coremark

■ view the summary information for the F4 coremark
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Adding, 
Editing, and 
Purging 
Coremark 
Cards

If information about a coremark changes or needs to be corrected, you can 
edit the Coremark card. You can purge a Coremark card if you created it 
by mistake.

Before you can add or 
install a core, a Coremark 
Card must have been 
created at the Master Key 
Card screen.

To add a Coremark card
Always, add Coremarks from the Masterkey Card using the 2 Step 
process outlined on pages 6-13 and 6-14 and never from the 
Coremark card itself. There is one exception to this rule. If a Coremark 
is selective in that it is operated by other keys (Keymarks) and not one 
of it’s own. You will have to contact your local Stanley Security 
Solutions, Inc. office for special instructions.

To edit a Coremark card
1 Find the H1X Coremark card in the SYS-A masterkey system.

2 Select the Edit menu Button. 

3 Select Edit This Coremark Card (F5) 

4 Edit the fields as shown below.

5 Check that the information in the fields is correct.

6 Select Save. (F10)

When you purge a 
Coremark card, all Core 
cards for cores based on 
the coremark will also be 
purged or permanently 
deleted. 

If you decide not to purge 
the Coremark card, select 
No.

To purge a Coremark card

1 Find a Coremark card.

2 Select the Ctrl-Edit menu Button.

3 Select Purge This Coremark Card. (F4) 

A confirmation box appears asking, “Purge this coremark? Warning: 
This operation will also disconnect all keymarks and cores associated 
with this coremark!”

4 Select Yes.

Practice 
Activities

For practice, find the following coremark information. 

■ Doors operated by the F7 coremark

■ Employees with access to the E3 coremark 

■ The numbers of departments with access to cores based on the G2 
coremark

Field Information to change

Keymark H1
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Using the 
Automatic Pin 
Segment 
Calculator

The Pin segments for this coremark detail shows the pin segments for 
cores based on the selected coremark.

This detail serves as an automatic pin segment calculator. If your records 
include enough information, Keystone 600 automatically calculates the pin 
segments for cores based on the selected coremark.

If your records don’t 
include enough 
information to use the 
automatic pin segment 
calculator, a message 
appears on the screen 
stating, “Insufficient or 
invalid information to 
calculate pin segments”.

For the automatic pin segment calculator to always work correctly:

■ Your records must include a card for each keymark and coremark that 
is part of each masterkey system.

■ All codes must be correct.

■ All keymark series must be correct and complete.

If your records are 
complete, you can view 
the pin segment 
information. Then you 
can edit and print a work 
slip, which includes the 
information needed to 
build cores based on the 
selected coremark and to 
cut keys based on the 
coremark’s base keymark.

The Keymarks area of the Pin segments for this coremark detail shows the 
keymark code for the selected coremark’s base keymark. This area also 
shows the keymark code for all other keymarks in your records that access 
the selected coremark, such as the grandmaster keymark and the control 
keymark.

The pin segments area of this detail shows the pin segment pattern for the 
selected coremark. (The left-most column shows the pin segments for the 
barrel closest to the rear of the core, as shown in the figure on the detail.) 
For each barrel, the A pin segment, which is inserted in the bottom of the 
barrel, is listed at the bottom of the column.

Figure 6.11 Pin segment calculator screen showing what pin segments 
to use for the coremark
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If your records for keymarks are complete, you can use the information on 
this detail to build a core based on the selected coremark and to cut keys 
based on the coremark’s base keymark. If the core you want to build is a 
figure-8 core – a core that can be removed using a control key—make sure 
the Figure-8 Core box is checked (click on the box). If the core can’t be 
removed (for example, a 5E cylinder), remove the check from the Figure-8 
Core box.

From the Pin segments for this coremark detail, you can create and print a 
work slip showing the information needed to build the cores and to cut the 
keys. The work slip includes additional instructions, such as the number of 
cores and keys to build, and the date when the work should be completed.

To use the automatic pin segment calculator and to edit and 
print a work slip
1 Open the Cards menu (press Alt + C) and select Coremark (press K), 

or click the mouse on the Coremark card tab.

2 Select the Pin segments for this coremark detail (press Shift, then 
press F7. Or click the mouse on the Pin Segments tab near the bottom 
of the card).

3 Use the Coremark finder to select the following coremarks and look at 
the pin segment information that appears on the screen.

1BB1

1BB2

1BB3

1BB4

4 Use the Coremark finder to select the 1BB3 coremark.

5 Select Show Work Slip (press F6 or click the mouse on Show Work 
Slip).

The Work Slip dialog box appears, like the one on the next page.

6 Complete the fields as shown below.

Figure 6.12 The work slip dialog box
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Mark is the location for 
the core number stamped 
on cores belonging to the 
masterkey system. “F” 
indicates face and “S” 
indicates side.

Core Finish can be 1 to 6 
characters. 

Keystamp can be up to 8 
characters in length.

In the Issued to field, 
indicate the person who 
is receiving the work slip.

7 To print the work slip, select Print Work Slip (press F8 or click the 
mouse on Print Work Slip) if your computer is connected to a printer. 
Then complete the appropriate fields and select OK.

Field Information to enter

Core Finish 606

Number of Cores 2

Number of Keys 4

Issued To JOAN T. BENSON, SECURITY

Special Instructions PREPARE IMMEDIATELY

Completed By Date 1/6/97
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Using the 
Manual Pin 
Segment 
Calculator

The manual pin segment calculator, shown below, lets you calculate the 
pin segments for a core based on a particular coremark and it’s associated 
Keymarks. 

In the System Type field, 
enter the type of 
masterkey system the 
core belongs to.

In the Pins field, select 
the number of barrels in 
the core.

A pin segment is the 
cylindrical-shaped part 
that fits into the barrels 
of a core. The sequence of 
varying length pin 
segments in a core is 
what creates the 
combination for a core.

To use the manual pin segment calculator, you need to know the keymark 
codes for all keymarks that operate the coremark.

When you are using the manual pin segment calculator, you can edit and 
print a work slip showing the information needed to build cores and to cut 
keys based on the information you provided. The work slip includes 
additional instructions, such as the number of cores and keys to build, and 
the date when the work should be completed.

Figure 6.13 Pin segment calculator screen showing the calculation of 
the pins segments to use for a coremark.
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To use the manual pin segment calculator
1 Open the Cards menu (press Alt+C) and select Masterkey (press M), 

or click the mouse on the Masterkey card tab.

2 Select Find a Masterkey System (press F10 or click the mouse on Find 
a Masterkey System).

3 Select SYS-B (highlight SYS-B and press Enter, or click the mouse 
twice on SYS-B.)

To clear the keymark 
codes and pin segment 
information, select Clear. 

To return to the 
Masterkey Card, select 
Done.

Notice that the codes for 
the control keymark and 
the grandmaster keymark 
automatically appear 
from the information on 
the Masterkey Card.

4 Select the Ctrl-Edit Menu Button and then press (F7).

5 Complete the System Type and Pins fields as shown below.

6 Since the core we want to build is a figure-8 core – a core that can be 
removed using a control key – make sure the Figure-8 Core box is 
checked (click on the box).

7 In the area on the left of the Manual Pin Segment Calculator, type the 
following information for the 1BB3 coremark.

8 Check that all of the information you provided is correct.

Figure 6.14 The work slip dialog box

Field Information to enter

System Type A2

Pins 7

Field Information To Enter

M 6971608

OP 6979220
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9 Select Calculate (press Alt+C or click the mouse on Calculate).

The pin segments area, on the right of the Manual Pin Segment 
Calculator, shows the pin segment pattern for the core. (The left-most 
column shows the pin segments for the barrel closest to the rear of the 
core.) For each barrel, the A pin segment, which is inserted in the 
bottom of the barrel, is listed at the bottom of the column.

10 To print the pin segment information, select Print (press F8 or click the 
mouse on Print Pin Segment). Then complete the appropriate fields 
and select OK.

To edit and print a work slip
1 To create and print a work slip, select Work Slip (press Alt+W or click 

the mouse on Work Slip).

The Work Slip dialog box appears.

2 Complete the fields as shown below.

Mark is the location for 
the core number stamped 
on cores belonging to the 
masterkey system. “F” 
indicates face and “S” 
indicates side.

Core Finish can be 1 to 6 
characters. 

Keystamp can be up to 8 
characters in length.

3 To print the work slip if your computer is connected to a printer, select 
Show Pin Segments (click the mouse on Show Pin Segments)

Then select Print Pin Segments (press F8 or click the mouse on Print 
Pin Segments). Then complete the appropriate fields and select OK.

4 To erase all of the codes, select Clear Codes (press Alt + L or click the 
mouse on Clear Codes).

Field Information to enter

Coremark 1BB3

Mark (S/F) S

Keyway (for core) A

Core Finish 606

Number of Cores 2

Keymark 1BB3

Keystamp 279X292

Number of Keys 2

Keyway (for key) A

Issued To THOMAS P. JONES, BUILDING 
MAINTENANCE

Special Instructions GIVE THE KEYS AND CORES TO 
HOWARD LONG

Completed By Date 6/7/96
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Practice 
Activity

Use the manual pin segment calculator to calculate the pin segments for a 
core based on a coremark you select from the code sheet. Also, generate 
a work slip for the core.

When you’ve finished using the manual pin segment calculator, Select 
Done

Adding and 
Removing 
Selectivity for a 
Coremark

Keystone 600 lets you add selectivity for a coremark. Coremark selectivity 
gives an operating level keymark, other than the base keymark, access to 
a selected coremark. For example, suppose everyone in a building needs 
access to the front door. However, the same key that operates their private 
offices must also operate the lock for the front door. You can accomplish 
this special need by adding selectivity for the coremark. Then, 
Keystone 600 takes into account the extra keymarks when it calculates the 
pin segments for a core based on the coremark. 

Keystone 600 also lets you remove selectivity for a coremark.

To add selectivity for a coremark
1 Find a coremark.

Keymarks that are 
selective into a 
Coremark, generally are 
keymarks at the 
operating level. 

Normally, in the 
Keymarks available to 
add selectivity list 
Keystone 600 shows all 
keymarks that can be 
made selective for this 
coremark. But you can 
restrict the list to view 
only the keymarks at one 
or more levels and with 
one or more selected 
statuses.

Any selective keymarks 
for the selected coremark 
have “(sel)” next to them.

If you decide not to add 
coremark selectivity, 
select No.

2 Select the Keymarks/Selectivity detail (press Shift, then press F6. Or 
click the mouse on the Keymarks/Selectivity detail tab near the bottom 
of the card).

The Keymarks for this coremark detail shows all current keymarks 
corresponding to the selected coremark.

3 Select Add Selectivity. (F7) 

The Keymarks available to add selectivity list appears showing the 
keymarks that can be made selective for the selected coremark.

4 Highlight the 1BB4 keymark, or any Keymark you wish.

5 Select Confirm. (press ENTER) 

A confirmation box appears asking, “Add coremark selectivity?”

6 To add coremark selectivity, select Yes.

Your list of Keymarks for this Coremark will now show the extra keys 
with (Sel) next to them.
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To remove selectivity for a coremark
1 Find the E1X coremark.

2 Select the Keymarks/Selectivity detail.

The Keymarks for this coremark detail shows any keymarks that can 
access any coremarks that the selected keymark can access.

Normally, Keystone 600 
shows all selective 
keymarks for this 
coremark. But you can 
restrict the list to view 
only the keymarks at one 
or more levels and with 
one or more selected 
statuses.

If you decide not to 
remove coremark 
selectivity, select No.

3 Select Remove Selectivity. (F9)

A list appears showing the selective keymarks for your selected 
coremark.

4 Highlight any or all keymarks.

5 Select Confirm (press ENTER) 

A confirmation box appears asking, “Remove coremark selectivity?”

6 Select Yes.

You have now removed one or more keymarks and their keys that would 
operate this Coremark and any Cores combinated to it. 

You can view phantom Keymarks by pressing F5. You can view phantom 
Keys by selecting the keys detail tab and pressing F5.

Module 
Review

In this module, you learned about

■ finding, printing, and viewing information about masterkey systems, 
coremarks, and keymarks

■ adding and editing cards to track information about masterkey 
systems, coremarks, and keymarks

■ creating and printing work slips using the automatic pin segment 
calculator and the manual pin segment calculator

■ creating selective keymarks for a coremark
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MODULE 7

Purpose of 
Module 7

The purpose of this module is to learn about 

■ managing your Keystone 600 site

■ managing users at your site

■ managing facilities at your site

■ other topics to pursue on your own

Objectives for 
Module 7

When this module is complete, you’ll be able to

■ find, print, and view information about your site, and the users and 
facilities at your site 

■ add and edit user cards and facility cards

■ purge user cards

■ assign user permissions 

■ customize the appearance of Keystone 600

■ backup facilities at your site and restore facility backups

Overview The topics covered in this module are

■ Managing information for your site such as

— viewing and printing the card

■ Managing information for users such as

— viewing and printing cards

— adding, editing, and purging cards

— changing user permissions

— customizing the appearance of Keystone 600 for a user

■ Managing information for facilities such as

— viewing and printing cards

— adding and editing cards

— backing up facilities

— restoring facility backups

■ Exploring other topics on your own
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Activity 1: 
Managing 
your 
Keystone
600 Site

The Keystone 600 site is the location running Keystone 600. Each site can 
manage one or more facilities. Keystone 600 is shipped with two facilities. 
If more are required, please contact your local Stanley/BEST office for 
purchase information. Keystone 600 tracks information about the site, 
facilities managed at the site, and users for the site. You can view the site 
card or print the site card.

A site can have one or 
more facilities. Please 
contact your local 
representative’s office for 
purchase information.

The Site data detail shows information for the site. This detail includes the 
name of the site’s Stanley Security Solutions representative, and his or her 
phone number and fax number. All of the information on this detail is 
provided by Stanley Security Solutions and automatically appears on the 
detail. You can’t edit this information.

Finding, 
Viewing, and 
Printing Site 
Cards

To view the Site card
1 Select the Site card.

2 If your computer is connected to a printer, select Print Site Card. Then 
complete the appropriate fields and select OK.

To view the Site card details
1 Select the detail you want.

The information at the 
top of the Site card—
Serial Number, Customer, 
and Installation Date—
also is provided by 
Stanley Security 
Solutions and 
automatically appears on 
the Site card. 

You can’t add, edit, or 
delete the Site card.

2 For an explanation of the detail you’re viewing, select Help.

3 When you’ve finished viewing the help, select Close.
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Activity 2: 
Managing 
Users

Users are people who have access to the Keystone 600 system. If you 
have the necessary permissions, Keystone 600 lets you define the login 
and password for each user. You also can determine which cards a user 
can view and which activities a user can perform using Keystone 600.

When you add a user for your Keystone 600 site, you need to add a User 
card. If information about the user changes or needs to be corrected, you 
can edit the User card. When a user no longer needs access to 
Keystone 600, you can purge the User card. You also can view a User card 
or print a User card.

Finding, 
Viewing, and 
Printing User 
Information

To view a User card
1 Select the User card.

2 Select Find a User Card. (F10)

3 Highlight a User Login name and press ENTER.

If the Super User 
permission is checked, all 
other permissions are 
checked as well. A super 
user can view all cards 
and perform all 
activities.

To view the User card details and cross references
1 Select the detail you want.

2 For an explanation of the detail you’re viewing, select Help.

3 When you’ve finished viewing the help, select Close.

To print a detail or cross reference you’re viewing
Select Print User Card. Then complete the appropriate fields and 
select OK.

Adding, 
Editing, and 
Deleting a User 
Card

Each User card provides general information about a Keystone 600 user. 
Before a user can log into Keystone 600 using his or her login and 
password, you must create a User card for the user. If information about 
the user changes or needs to be corrected, you can edit the User card.

When you add a user 
card, Keystone 600 
automatically defines the 
permissions for the user. 
The user can view all 
cards, but the user doesn’t 
have any other 
permissions.

To add a User card
1 Select a User Card.

2 Select Add New User Card. (F3)

The Add User dialog box appears.

The description can be 
from 1 to 30 characters.

3 Complete the fields as shown below.

Field Information to enter

User Login JCLARK

Password KEYSHOP

Description KEY SHOP ANNEX

Card Colors (Leave as is)
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If you want Keystone 600 
to appear in color for this 
user, check the Card 
Colors box. If you want 
Keystone 600 to appear in 
black, white, and shades 
of gray, remove the check 
from the Card Colors box.
Check that the 
information in the fields 
is correct.

4 Select Save. (F10)

To edit a User card
1 Find the User card for JCLARK.

2 Select the Ctrl Edit menu Button.

3 Select Edit This User Card. (F5)

4 Edit the field as shown below.

5 Check that the information in the fields is correct.

6 Select Save. (F10)

To purge a User card
1 Find the User card for JCLARK.

2 Select the Ctrl-Edit menu Button.

If you decide not to purge 
the User card, select 
Cancel.

3 Select Purge This User Card. (F4)

A confirmation box appears asking, “Purge this user?”

4 To purge the User card, select YES.

Practice 
Activity

1 Add User cards for the following two users:

2 Edit the JENNY user card. Change the password to JKH9096.

Field Information to change

Password KEYS

Field Information to enter

User Login JENNY

Password JENNY411

Description DATA ENTRY 102

Card Colors Check this box

Field Information to enter

User Login GEORGE

Password GEORGE37

Description KEY SHOP ROOM 37

Card Colors Remove the check from this 
box
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User 
Permissions

This detail shows the permissions for the selected user. Permissions 
determine which cards a user can view and which activities a user can 
perform using Keystone 600. Each permission selected for the user has a 
check mark next to it.

To view a user’s 
permissions, click the 
mouse on the General 
Permissions tab near the 
bottom of the screen, if 
not already displayed. 

If the Super User 
permission is checked, all 
other permissions are 
checked as well. A super 
user can view all cards 
and perform all 
activities.

The permissions in the first three columns determine which cards the user 
can view. The permissions in the right-most column determine which 
activities a user can perform, as described in the table below.

Figure 7.1 User Permissions screen showing all permissions granted 
to User BEST.

This permission Lets the user

View Codes View keycuts and keymark codes. If 
a user doesn’t have this permission, 
asterisks appear instead of keycuts 
and keymark codes.

Updates Add, edit, and delete cards, and 
restore backups. To add, edit, or 
delete a particular card, the 
Updates permission and the per-
mission for viewing the card must 
be checked.
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For example, a supervisor or system administrator usually is a “super 
user.” A super user automatically has all permissions, including the ability 
to add users and select permissions for them. 

A user who issues keys to employees might have Employee and 
Transactions permissions only. This user can issue keys to employees, but 
can’t add Employee cards or key cards. Only the Employee card appears 
when this user logs into Keystone 600.

To edit a user’s permissions
1 Find a User card for the user whose permissions you want to edit.

To check a box or remove 
a check from a box, click 
the mouse on the box. Or, 
press Tab until the box 
you want to change is 
highlighted and press the 
space bar.

2 Select the Ctrl Edit menu Button.

3 Select Edit User General Permissions. (F7)

The User Permissions dialog box appears. Permissions selected for 
the user have checks next to them.

4 Check the boxes next to the permissions you want the user to have. 
Remove the check from the boxes next to the permissions that you 
don’t want the user to have.

5 Select Save. (F10)

Transactions Perform transactions. To perform a 
particular transaction, the Transac-
tions permission and the permis-
sion for viewing the appropriate 
card must be checked.

For example, to issue a key, the 
Employee card permission and the 
Transactions permission must be 
checked.

Pin Segment Calcu-
lator

Use the automatic pin segment
Calculator calculator. To use the 
automatic pin segment calculator, 
both the Pin Segment Calculator 
permission and the View Codes 
permission must be checked.

This permission Lets the user
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Practice 
Activity

1 Read through the job description for Jenny. Then, refer to the table on 
the next page and check the appropriate permissions for her. 

Jenny enters all of the employee information for the Keystone 600 
system. Sometimes she needs to add information about departments. 
She does not issue keys to employees. She does not need to access 
any other records.

2 Repeat this exercise for George.

George manages all data related to creating and installing cores. He 
needs to access coremark information when adding cores for the 
facility. He tracks all information involving installing cores in doors and 
locks, and storing cores in cabinets. He also keeps the records about 
doors and buildings up to date. George does not perform any activities 
involving employees or keys.

3 Repeat this exercise for the Key Shop.

The main Key Shop cuts keys and builds cores for the facility. 
Personnel in the Key Shop use the pin segment calculator. They also 
need to be able to look up keycut information when cutting keys. They 
only need to view information. They do not update information.

Permission Jenny George Key Shop

Building

Cabinet

Core

Coremark

Department

Door

Employee

Facility

Hook

Key

Keymark

Keyring

Lock

Masterkey

Out of Service
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4 Create a User card for George and edit the user permissions 
according to the information entered in the table above.

5 Log off, then log in as George. Notice which cards George can and 
can’t access. Use the password GEORGE37.

6 Now, log off and log in as BEST. Use the password BEST.

Note: After adding a new User Card with Super User permissions. Go 
to the BEST User Card and edit the password field (Ctrl + F5) to a new 
password.

Product

Reports

Site

Unassigned

User

Super User

View Codes

Updates

Transactions

Pin Segment 
Calculator

Permission Jenny George Key Shop
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Activity 3: 
Managing 
Facilities

Facilities are groups of buildings’ masterkey systems and employees 
tracked by Keystone 600. A facility can have one or more masterkey 
systems. Keystone 600 can be used to manage one facility or many 
facilities.

Caution: Do not add a Facility Card with out contacting Tech 
Support first. A Facility is a separate database and one Facility 
cannot see or interact with another one. A Facility can not be 
deleted.

You can’t delete a Facility 
card.

Keystone 600 lets you perform backups for each facility. A backup can be 
used to take the records to another location or can serve as a duplicate for 
safekeeping.

Note: The Backup option only backs up data in the Facility Card you 
are looking at.

For each facility, you can define which detail or cross reference 
automatically appears when you select a card. You also can define 
whether serial numbers are optional or mandatory when adding Key cards, 
Core cards, and Part/Lock cards for the selected facility.

Finding, 
Viewing, and 
Printing 
Facility Cards

To view the Facility card for a facility
1 Select the Facility card.

2 Select Find a Facility.

The Summary detail 
shows the count of 
buildings, departments, 
doors, and employees in 
the selected facility. It 
also shows the count of 
cores, keys, keyrings, and 
locks in the selected 
facility, including their 
current disposition.
The Issued column 
includes items that are 
installed and items that 
are issued. The Returned 
column includes items 
that are unassigned and 
items that are on a 
cabinet hook.

The Items due detail 
shows which items issued 
to employees are due to 
be returned by today or 
by a designated date for 
the selected facility.

3 Highlight the Customer facility.

4 Select Select Entry.

5 If your computer is connected to a printer, select Print Facility Card. 
Then complete the appropriate fields and select OK.

To view the Facility card details
1 Select the appropriate tab near the bottom of the screen.

2 For an explanation of the detail you’re viewing, select Help.

3 When you’ve finished viewing the help, select Close.

To print a detail you’re viewing
Select Print Facility Card. Then complete the appropriate fields and 
select OK.
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Practice 
Activities

Select the Demo facility and find the following facility information.

■ The total number of locks issued.

■ The number of buildings in the facility.

■ The items due by today.

To add a Facility card

Note: Additional Facilities must be purchased.

When you access a 
facility, the facility name 
appears at the top of your 
computer screen.

The Path information 
defaults to the C drive. 
Please contact Keystone 
600 Support before 
making any changes.

Important: Never add a Facility card before contacting Tech 
Support first. The following is an example only. Do not 
do the following instructions without contacting 
the Keystone 600 product support group.

1 Select the Facility card.

2 Select Add New Facility Card.

The Add Facility dialog box appears.

3 Complete the fields as shown below.

4 Check that the information in the fields is correct.

5 Select Save. (F10)

To edit a Facility card
1 Find the Demo Facility card.

2 Select the Ctrl-Edit menu Button.

3 Select Edit This Facility Card. (F5)

4 Edit the field as shown below.

5 Check that the information in the field is correct.

6 Select Save. (F10)

Field Information to enter

Name TEST

Path C:\KS600WIN\DATA2

Description NEW FACILITY

Field Information to change

Description PRINTING PLANT FACILITY
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Editing Detail 
Defaults

The detail defaults for a facility indicate which detail or cross reference 
appears when you first select a card for the selected facility. By editing the 
detail defaults for the facility, you can select the detail or cross reference 
you use most often for each card. 

For example, if Doors is selected for the Building field, when you select the 
Building card, you see the Doors in this building detail.

To edit detail defaults for a facility
1 Find the Facility card for the facility that you want to edit detail defaults 

for.

2 Select the Edit menu Button.

3 Select Edit Detail Defaults. (F8)

4 Select History next to the Employee field.

5 Select Save. (F10)

6 Select a Employee card.

Notice that the History detail appears automatically.

Figure 7.2 Screen showing the setup of what detail cross reference 
appears first on each card

For example, this 
setup will bring up 
the cores detail 
when you select 
the building card.
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Backing Up a 
Facility

When you back up a facility you save a copy of all of the records for a 
facility. A backup can be used to take the records to another location or 
can serve as a duplicate for safekeeping.

Note: Only the server installation or a program loaded in stand-alone 
mode can make a backup or restore a Facility. A backup can only be 
made to a sub-directory on the hard drive or to a USB thumb drive. You 
cannot backup to an A: drive or a CD-ROM.

To back up a facility
Note: a Client machine 
cannot perform a backup 
or a restore. The option is 
unavailable (‘grayed out’) 
in the software.

1 Find the Demo Facility card.

2 Select Back Up Facility. (F5)

The Backup Facility dialog box appears.

3 Select the disk or USB drive.

4 Select Start Backup.

Restoring a 
Facility Backup

When you restore a backup of a facility, you copy of all of the records for a 
facility from a backup file to your computer’s hard disk. You can restore a 
backup to move records from one location to another. You also can restore 
a backup if you made mistakes adding, editing, or deleting information for 
a facility and want to return to a previous version of the records.

Note: You cannot restore from the client.

To restore a facility backup
1 Find the Demo Facility card.

2 Select the Edit menu Button.

3 Select Restore Facility. (F7)

The Restore Facility dialog box appears.

4 Select the disk or USB drive.

5 Select Start Restore.

A message appears stating, “Restore facility to…”

6 Select OK.

A message appears stating, “This facility is not empty. All previously 
entered data for this facility will be overwritten or destroyed. Continue?”

7 Select Yes.

8 Select OK.
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Activity 4: 
Topics to 
Pursue on 
Your own

The topics listed below are advanced topics that you might want to pursue 
on your own. The Help system provides information about these topics.

■ Creating a key agreement or return receipt. A key agreement is a 
document describing rules for a key issued to an employee and often 
signed by the employee. A key agreement might indicate how the 
employee should treat the key, when the key must be returned, and 
what the employee should do if the key is lost or stolen.

To edit an agreement use 
Microsoft Notepad to 
select the KS600N5 
directory and then the 
Employee.KHA text file. 
Never move or change the 
first line that has the 
agreement name.

Keystone 600 provides the three standard key agreements listed below. 
You can create additional key agreements to suit your facility’s needs, or 
modify the standard agreements and return receipts.

■ Contractor Agreement for keys issued temporarily to contractors 
and similar personnel

■ Employee Agreement for keys issued to regular employees
■ Security Agreement for keys issued to security personnel

■ Purging histories. You can purge a record of a transaction that 
appears on any of the following History details. When you purge a 
history record, you remove it permanently from your records.

— Core history

— Door history

— History for items held by this employee

— History for items on this hook

— History for out of service items

— History for unassigned items

— Key history

— Keyring history

— Lock history

■ Editing a facility’s serialization configuration. The Facility 
serialization configuration detail shows whether serial numbers are 
optional or mandatory when adding Key cards, Core cards, and Lock 
cards for the selected facility.

If a serial number is mandatory for Key cards, Keystone 600 
automatically generates a sequential key number based on the 
selected keymark when you add a Key card. If a serial number is 
mandatory for Core cards, Keystone 600 automatically generates a 
sequential core number based on the selected coremark when you 
add a Core card. If a serial number is mandatory for Lock cards, 
Keystone 600 automatically generates a sequential serial number 
based on the selected product when you add a Lock card.
Issue 3 March 2007 Page 7-13



Module 7 Keystone 600N5 Training Manual
Module 
Review

In this module, you learned about

■ finding, printing, and viewing information about sites, users, and 
facilities

■ adding, editing, and deleting User cards

■ assigning user permissions

■ adding and editing Facility cards

■ customizing the appearance of Keystone 600

■ backing up and restoring a facility
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A access control system
Your entire system for restricting the movement of people into and within 
areas protected by the system.

area
Part of a Door. An area can be defined by location, such as “FIRST 
FLOOR” or by function, such as “HUMAN RESOURCES”.

B backup
Copy of all records for a selected facility saved to a mapped drive or USB 
drive. A backup can be used to take the records to another location or can 
serve as a duplicate for safekeeping.

base report
Formatted report provided with Keystone 600. Base reports can be 
customized to create new reports. The word BASE appears on the right 
edge of all base reports.

building
Any structure in a facility. A building can be assigned to a facility zone. A 
door can be assigned to a building and to an area in a building.

C cabinet
Place where cores, keys, keyrings, and/or locks are stored. Cabinets, 
closets, file drawers and other storage areas can be considered cabinets.

code, keymark
Sequence of numbers indicating the keycut for a keymark. This code can 
be used to cut a key for a keymark. The left-most number is the cut closest 
to the end of the key’s blade.

control key
Key that inserts and removes cores in a masterkey system. A control key 
has the same security level as a grand master key.
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core
Interchangeable device that can be installed in a lock or door and operated 
by a key. Has a direct link to a Coremark.

coremark
Sequence of letters and numbers that indirectly corresponds to a pin 
segment configuration for a core in a masterkey system.

coremark selectivity
Process of giving more than one operating keymark access to a selected 
coremark.

core number
Sequence of letters and numbers that identifies a particular core. A core 
number often is directly related to the core’s coremark.

D department
Functional or other division of employees at a facility. Using Keystone 600, 
employees can be assigned to departments so Keystone 600 can track 
access provided to each department.

description
Brief information you type when creating or editing a Keystone 600 card. 
Descriptions can help identify particular people, places, and things in your 
records.

destroyed
One of three dispositions (in addition to lost and stolen) for an item that is 
out of service.

disposition
Location or condition of an item tracked by Keystone 600. An item can be

■ issued to an employee
■ installed in a lock (if the item is a core)
■ installed in a door (if the item is a core or lock)
■ attached to a keyring (if the item is a key)
■ on a cabinet hook
■ out of service (lost, stolen, or destroyed)
■ unassigned

door
Access point in a facility. Doors, gates, padlocks, and even drawers can be 
considered doors. A door can be assigned to a building and to an area of a 
building. Locks and cores can be installed in doors.

door number
Sequence of letters and/or numbers that identifies a particular door.
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E employee
Person who works at a facility tracked by Keystone 600.

F facility
Group of buildings and employees tracked by Keystone 600. A facility can 
have one or more masterkey systems. Keystone 600 can be used to 
manage one facility or many facilities.

G grand master key
Key that normally operates all locks in a masterkey system. However, a 
masterkey system might be designed so the grand master key does not 
operate selected locks, such as cash boxes, hazardous waste areas, or 
drug cabinets.

H hook
Place within a cabinet where cores, keys, keyrings, and locks are stored. 
Hooks, shelves, drawers, and storage boxes can be considered hooks.

I ID
Number, name, or sequence of letters and numbers used to identify an 
employee, core, key, keyring, or lock. When used to refer to a core, an ID 
is a core number. When used to refer to a key, an ID is a key number. 
When used to refer to a lock, an ID is a lock serial number.

item
Cores, keys, keyrings, and locks.

K key agreement
Document describing rules for a key issued to an employee and often 
signed by the employee. A key agreement might indicate how the 
employee should treat the key, when the key must be returned, and what 
the employee should do if the key is lost or stolen.

key
Device that operates a core or lock. A key or an electronic access device 
can be considered a key. Has a direct link to a Keymark.

keycut
Sequence of numbers indicating the cuts for a key. The terms keycut and 
code are used interchangeably. Normally seven cuts on a Stanley/BEST 
System.

key level
Security level of a key or keymark in a masterkey system. Levels include 
control, grand master, master, submaster, and operating.

key number
Sequence of letters and numbers that identifies a particular key.
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keymark
Sequence of letters and numbers that indirectly corresponds to a keycut 
pattern for a key or group of keys that operates a particular core or lock.

keymark code
Sequence of numbers indicating the keycut for a keymark. This code can 
be used to cut a key for a keymark. The left-most number is the cut closest 
to the end of the key’s blade. Normally seven cuts on a Stanley/BEST 
System.

keymark level
Security level of a key or keymark in a masterkey system. Levels include 
control, grand master, master, submaster, and operating.

keymark series
Letter or sequence of letters that identifies a group of related keymarks in 
a masterkey system.

keyring
Device that keys are attached to so they can be carried or stored easily.

keystamp
Message, name, or other words stamped on all keys in a particular 
masterkey system. For example, “DO NOT DUPLICATE” or a company 
name can be keystamps.

Keystone 600 system
The Keystone 600 program and parameters that define how the program 
operates.

keyway
Letter or sequence of letters that indicates the configuration of the 
groove(s) along a key blade.

L login, user
Name or number that identifies a person or group of people that uses the 
Keystone 600 system. A user must type his or her login, in addition to his 
or her password, to access Keystone 600.

level, key or keymark
Security level of a key or keymark in a masterkey system. Levels include 
control, grand master, master, submaster, and operating.

lock
Security device that protects a door. In a BEST masterkey system, one or 
more interchangeable cores can be installed in a lock. Door locks, 
padlocks, cabinet locks, and other types of locks are considered locks.

lock serial number
Sequence of numbers and/or letters that identifies a particular lock.
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M manufacturer
Company that makes a product.

mark
Location of the core number stamped on cores in a particular masterkey 
system. “F” indicates face and “S” indicates side.

master key
Key that operates a large group of cores or locks, such as all locks in a 
building, on a floor, or for a department.

masterkey system
System comprised of keymarks and coremarks that lets a single key 
operate many cores, and also lets each core be operated by its own key.

O operating key
Key that operates one lock or a group of locks keyed alike.

out of service
Possible disposition for items tracked by Keystone 600. Destroyed, lost, 
and stolen items are considered out of service. 

When a core is installed in a lock and the lock is out of service, the core is 
considered to be both installed in the lock and out of service. When a key 
is attached to a keyring and the keyring is out of service, the key is 
considered to be both attached to the keyring and out of service.

P password
Sequence of three to 15 letters and/or numbers assigned to each 
Keystone 600 user login to provide security for the Keystone 600 system. 
A user must type his or her password, in addition to his or her login, to 
access Keystone 600. Normally, a password is known only by the 
Keystone 600 administrator and the user.

path definition
Information that indicates to Keystone 600 where the records for a facility 
are stored. A path must be defined using DOS conventions. For example, 
the path definition “C:\K600N5\DATA” indicates that the records for this 
facility are stored in the “DATA” subdirectory, in the “K600N5” directory, on 
computer drive “C”.

pin
Barrels in a core. The number of barrels in a core can vary, although 
standard BEST cores have seven barrels.
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pin segment
Cylindrical-shaped part that fits into the barrels of a core. The sequence of 
varying length pin segments in a core is what creates the combination for a 
core.

product
Type of core, key, lock, or other item produced by a particular 
manufacturer.

R report
Summary of selected information in a facility’s records. Keystone 600 
provides a variety of formatted reports, called base reports. You can use 
the base reports that are provided and you can customize reports. Reports 
can be viewed on your computer screen or printed at a printer connected 
to your computer.

S selectivity, coremark
Process of giving more than one operating keymark access to a selected 
coremark.

serial number, lock
Sequence of numbers and/or letters that identifies a particular lock.

series, keymark
Letter or sequence of letters that identifies a group of related keymarks in 
a masterkey system.

site
Location that is running the Keystone 600 system. One site can manage 
the records for multiple facilities.

status
Condition of a coremark, keymark, or facility. The status of a coremark or 
keymark can be “IN USE”, “NOT USED”, “DO NOT USE”, or “OTHER”. 
The status of a facility is “AVAILABLE” if the facility’s records can be 
accessed at the current time or “UNAVAILABLE” if the records cannot be 
accessed.

stolen
One of three dispositions (in addition to lost and destroyed) for an item that 
is out of service.

submaster key
Key that operates part of a group of cores or locks operated by a related 
master key.

system, masterkey
System comprised of keymarks and coremarks that lets a single key 
operate many cores, and also lets each core be operated by its own key.
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T title
Employee job title.

transaction
Activity performed using Keystone 600 that changes the disposition of an 
item. Transactions include issuing items, returning items, transferring 
items, installing items, and removing items.

type
Category designated for a door or employee that is meaningful to your 
business.

U unassigned
Possible disposition for an item. If an item is not issued to an employee, 
installed in a lock or door, attached to a keyring, on a cabinet hook, or out 
of service (destroyed, lost, or stolen), it is considered unassigned.

When a core is installed in a lock and the lock is unassigned, the core is 
considered to be both installed in the lock and unassigned. When a key is 
attached to a keyring and the keyring is unassigned, the key is considered 
to be both attached to the keyring and unassigned.

When a card is created for an item, the item always is initially considered 
unassigned even if its disposition is immediately changed.

user
Person who has access to the Keystone 600 system.

user login
Name or number that identifies a person or group of people that uses the 
Keystone 600 system. A user must type his or her login, in addition to his 
or her password, to access Keystone 600.

Z zone
Part of a facility. A zone normally includes two or more buildings at a 
facility.
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